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ส่วนอุทกวิทยา 

สำนักบริหารจัดการน้ำและอุทกวิทยา กรมชลประทาน 



กำหนดการ 
โครงการฝึกอบรมเชิงปฏิบัติการหลักสูตรการใช้งานโปรแกรม Aquarius เพ่ืองานทางอุทกวิทยา 

ระหว่างวันท่ี 24 – 28 กุมภาพันธ์ 2568 
ณ เลอ บาหลี รีสอร์ท แอนด์ สปา ต.นาเกลือ อ.บางละมุง จ.ชลบุรี 

 
วันท่ี 24 กุมภาพันธ์ 2568 
เวลา 08.00 - 08.30 น. ลงทะเบียน และชี้แจงรายละเอียดโครงการ 
เวลา 08.30 - 09.00 น. ทดสอบความรู้ก่อนการฝึกอบรม และพิธีเปิดการฝึกอบรม 
เวลา 09.00 – 12.00 น. หลักการ ความสำคัญ และลักษณะทั่วไปของเส้นโค้งความสัมพันธ์ระหว่างระดับน้ำ 

กับปริมาณน้ำ (Rating Curve) 
เวลา 12.00 - 13.00 น. พักรับประทานอาหารกลางวัน 
เวลา 13.00 - 16.00 น. วิธีและเทคนิคการสร้างโค้งความสัมพันธ์ระหว่างระดับน้ำกับปริมาณน้ำ 
เวลา 17.00 – 18.00 น. พักรับประทานอาหารเย็น 
 
วันท่ี 25 กุมภาพันธ์ 2568 
เวลา 09.00 – 12.00 น. ท ี ่มาและความสำค ัญ หล ักการจ ัดทำความส ัมพันธ ์ระด ับน ้ำกับปร ิมาณน้ำ 

ด้วยโปรแกรม Aquarius 
เวลา ๑2.00 – ๑3.๐๐ น. พักรับประทานอาหารกลางวัน 
เวลา 13.00 - 16.30 น. กระบวนการจัดทำความสัมพันธ์ระดับน้ำกับปริมาณน้ำด้วยโปรแกรม Aquarius 
เวลา 17.00 – 18.00 น. พักรับประทานอาหารเย็น 
 
วันท่ี 26 กุมภาพันธ์ 2568 
เวลา 09.00 – 12.00 น. กระบวนการจัดทำความสัมพันธ์ระดับน้ำกับปริมาณน้ำด้วยโปรแกรม Aquarius (ต่อ) 
เวลา ๑2.00 – ๑3.๐๐ น. พักรับประทานอาหารกลางวัน 
เวลา 13.00 - 16.30 น. การออกรายงานระดับน้ำ-ปริมาณน้ำ 
เวลา 17.00 – 18.00 น. พักรับประทานอาหารเย็น 
 
วันท่ี 27 กุมภาพันธ์ 2568 
เวลา 09.00 – 12.00 น. การออกรายงานระดับน้ำ-ปริมาณน้ำ (ต่อ) 
เวลา ๑2.00 – ๑3.๐๐ น. พักรับประทานอาหารกลางวัน 
เวลา 13.00 - 16.30 น. การใช้งานโปรแกรม Aquarius ในการติดตามสถานการณ์น้ำ 
เวลา 17.00 – 18.00 น. พักรับประทานอาหารเย็น 
 
วันท่ี 28 กุมภาพันธ์ 2568 
เวลา 09.00 - 11.00 น. นำเสนอการใช้งานจริง การเปรียบเทียบข้อมูล ประโยชน์และปัญหาอุปสรรค 
เวลา 11.00 - 12.00 น. ท ดส อ บ คว า ม ร ู ้ ห ล ั ง ก า ร ฝ ึ ก อ บ ร ม / ป ร ะ เ ม ิ น ผ ล โ ค ร ง ก า ร ฝ ึ ก อ บ ร ม   

และพิธีปิดการฝึกอบรม 
เวลา 12.00 – 13.00 น. พักรับประทานอาหารกลางวัน 
 
หมายเหตุ      รับประทานอาหารว่างและเคร่ืองด่ืม เวลา  10.30 – 10.45 น. และเวลา 14.30 – 14.45 น. 



โดย
ดร.เมธาฤทธิ์ แนมสัย

หัวหน้าฝ่ายวิจัยและพฒันาวิศวกรรมการบรหิารจดัการน ้า

ส่วนวิจัยและพฒันาด้านวิศวกรรม ส้านักวิจัยและพัฒนา
กรมชลประทาน

หลักการ ความส้าคัญ และลักษณะ
ทั่วไปของเส้นโค้งความสัมพันธ์

ระหว่างระดับน ้ากับอัตราการไหล
ของน ้า (Rating Curve)



❑ ความส้าคัญของข้อมูลอัตราการไหลของน ้า          
ในงานชลประทาน

❑ การไหลในล้าน ้า

❑ การวัดข้อมูลน ้าท่า

❑  หลักการของความสัมพันธ์ระหว่างระดับน ้าและ
อัตราการไหลของน ้า

❑  ความส้าคัญของเส้นโค้งความสัมพันธ์ระหว่าง             
ระดับน ้ากับอัตราการไหลของน ้า

❑  ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้า
กับอัตราการไหลของน ้า

หัวข้อที่น้าเสนอ

2



ความส าคญัของข้อมลูอตัราการไหลของน ้า
ในงานชลประทาน

3



ที่มา : เสรี จันทรโยธา และชัยพันธุ์ 
รักวิจัย, 2560ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

เกี่ยวข้องกับ
กรมชลประทาน

ขอบข่ายของงานทางด้านวิศวกรรมแหล่งน ้า
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ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

ภารกิจของกรมชลประทาน

5

การพัฒนาแหล่งน ้าและเพิ่มพื นที่ชลประทาน

ตามศักยภาพของลุ่มน ้าให้เกิดความสดุล

ด้าเนินการป้องกันและบรรเทาภัย

อันเกิดจากน ้าตามภารกิจอย่างเหมาะสม

บริหารจัดการน ้าอย่างบูรณาการให้เพียงพอ                           
ทั่วถึง และเป็นธรรม

เสริมสร้างการมีส่วนร่วมในกระบวนการ                       
พัฒนาแหล่งน ้า และการบริหารจัดการน ้า



ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

โครงสร้างภายในกรมชลประทาน

6



ที่มา : เสรี จันทรโยธา และชัยพันธุ์ รักวิจัย, 2560
ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

การปฏิบติังานด้านวิศวกรรมแหล่งน ้า
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ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

ข้อมลูอตัราการไหลของน ้าในงานชลประทาน

การวิเคราะห์ข้อมูลในเชิงประยุกต์ ได้แก่ 
กราฟ รูป แผนที่ ตาราง เป็นต้น

การบริการข้อมูล ได้แก่ ข้อมูลรายวัน     
รายเดือน รายปี อัตราการไหลของน ้าสูงสุด

ชั่วขณะ (Momentary peak) 

รวบรวมข้อมูลจากแหล่งข้อมูลต่าง ๆ ทั ง
หน่วยงานภายใน และภายนอก ทุกวัน ทั งแบบ

รายวัน รายชั่วโมง และแบบ Real time

งานเก็บและวิเคราะห์ข้อมูล
(ส่วนประมวลและวิเคราะห์ฯ ส่วนอุทกวิทยา และ ศูนย์อุทกวิทยาชลประทาน                          

ส้านักบริหารจัดการน ้าและอุทกวิทยา)
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ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

อตัราการไหลของน ้าสงูสดุชัว่ขณะ (Momentary peak)

9

ค่าสูงสุดของอัตราการไหล (Peak Discharge) ในช่วงชั่วโมงแรกที่ท้าให้เกิด
อัตราการไหลสูงสุด โดยเป็นค่าที่สูงที่สุดของทั งปี ซึ่งอาจเกิดขึ นอย่างฉับพลันและ
ลดลงอย่างรวดเร็ว

Q1 Q2น ้าขาลง น ้าขาขึ น

น ้าที่ระดับเดียวกันแต่
ปริมาณน ้าแตกต่างกัน



ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

อตัราการไหลของน ้าสงูสดุชัว่ขณะ (Momentary peak)

10

ตัวอย่างสถานการณ์ที่เกิด Momentary Peak
1. ฝนตกหนักในเมือง (Urban Stormwater Runoff)
 • เมืองมีพื้นผิวแข็ง เช่น ถนน คอนกรีต ซึ่งท้ำให้กำรซึมซับน้้ำลดลง
• น้้ำจะไหลบ่ำลงสู่ท่อระบำยน้้ำอย่ำงรวดเร็ว ท้ำให้เกิด Momentary Peak สูงมำก
• อำจน้ำไปสู่ปัญหำน้้ำท่วมขัง หำกระบบระบำยน้้ำรองรับไม่เพียงพอ
2. น ้าท่วมฉับพลัน (Flash Flood)

 • ฝนตกหนักบนพื้นที่ลำดชันหรือลุ่มน้้ำขนำดเล็ก
• น้้ำจะไหลรวมกันอย่ำงรวดเร็วไปยังแม่น้้ำหรือล้ำธำร
• เกิด Momentary Peak สูงมำกในระยะเวลำสั้น ๆ ก่อนท่ีน้้ำจะลดลง

3. การปล่อยน ้าจากเข่ือน (Dam Release)
 • หำกมีกำรปล่อยน้้ำจำกเขื่อนในปริมำณมำกใน
ช่วงเวลำสั้น ๆ
• น้้ำท่ีไหลลงสู่แม่น้้ำจะเกิด Momentary Peak อย่ำง
ฉับพลัน



ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

งานวางแผนโครงการพัฒนาแหล่งน ้า (ชลประทาน และป้องกันและบรรเทาอุทกภัย)
(ส้านักบริหารโครงการ; ส้านักงานชลประทานที่ 1–17)

การศึกษาแผนแม่บท ได้แก่ ข้อมูลรายวัน ราย
เดือน รายปี อัตราการไหลของน ้าสูงสุดชั่วขณะ 

การศึกษาความเป็นไปได้เบื องต้น (preliminary 
study) ได้แก่ ข้อมูลรายวัน รายเดือน รายปี อัตรา
การไหลของน ้าสูงสุดชั่วขณะ  

การศึกษาความเหมาะสม (feasibility study)ได้แก่ 
ข้อมูลรายวัน รายเดือน รายปี อัตราการไหลของน ้า
สูงสุดชั่วขณะ 

การศึกษาผลกระทบ (impact study) ได้แก่ ข้อมูล
รายวัน รายเดือน รายปี อัตราการไหลของน ้าสูงสุด
ชั่วขณะ 

ข้อมลูอตัราการไหลของน ้าในงานชลประทาน
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ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

งานออกแบบ (ชลประทาน และป้องกันและบรรเทาอุทกภัย)
(ส้านักออกแบบวิศวกรรมและสถาปตัยกรรม; ส้านักงานชลประทานที่ 1–17)

ออกแบบด้านอุกวิทยา ได้แก่ ข้อมูลรายวัน รายเดือน รายปี อัตราการไหลของน ้าสูงสุดชั่วขณะ

ออกแบบด้านชลศาสตร์ ได้แก่ อัตราการไหลของน ้าสูงสุดชั่วขณะ ที่รอบปีการเกิดต่างๆ  
(Return Period)  

ข้อมลูอตัราการไหลของน ้าในงานชลประทาน
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ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

งานก่อสร้าง (ชลประทาน และป้องกันและบรรเทาอุทกภัย)
(ส้านักพัฒนาแหล่งน ้าขนาดกลาง; ส้านักพัฒนาแหล่งน ้าขนาดใหญ่; 

ส้านักงานจัดรูปที่ดินกลาง; ส้านักงานชลประทานที่ 1–17)

วางแผนงานก่อสร้าง ได้แก่ อัตราการไหลของน ้าสูงสุดชั่วขณะ ข้อมูลรายวัน รายเดือน รายปี

ข้อมลูอตัราการไหลของน ้าในงานชลประทาน
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ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

งานบริหารจัดการและบ้ารุงรักษา (ชลประทาน และป้องกันและบรรเทาอุทกภัย)
(ส้านักบริหารจัดการน ้าและอุทกวิทยา; ส้านักงานชลประทานที่ 1–17)

การบริหารจัดการน ้า ได้แก่ ข้อมูลรายชั่วโมง รายวัน รายเดือน รายปี 

อัตราการไหลของน ้าสูงสุดชั่วขณะ

ข้อมลูอตัราการไหลของน ้าในงานชลประทาน
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ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

งานประเมินผล(ชลประทาน และป้องกันและบรรเทาอุทกภัย)
(ส้านักบริหารโครงการ; ส้านักงานชลประทานที่ 1–17)

งานติดตามตรวจสอบผลกระทบสิ่งแวดล้อม ได้แก่ ข้อมูลรายวัน รายเดือน รายปี                         
อัตราการไหลของน ้าสูงสุดชั่วขณะ 

งานประเมินผลโครงการ ได้แก่ ข้อมูลรายวัน รายเดือน รายปี อัตราการไหลของน ้าสูงสุดชั่วขณะ

ข้อมลูอตัราการไหลของน ้าในงานชลประทาน
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ความส้าคัญของข้อมูลอัตราการไหลของน ้าในงานชลประทาน

งานวิจัยและพัฒนา (ชลประทาน และป้องกันและบรรเทาอุทกภัย)
(ส้านักวิจัยและพัฒนา)

การวิจัยและพัฒนาด้านวิศวกรรมชลศาสตร์ วิศวกรรมแหล่งน ้า วิศวกรรมชลประทาน  ได้แก่                     
ข้อมูลรายชั่วโมง รายวัน รายเดือน รายปี อัตราการไหลของน ้าสูงสุดชั่วขณะ 

ข้อมลูอตัราการไหลของน ้าในงานชลประทาน
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การไหลในล าน ้า
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การไหลในล้าน ้า

วัฏจักรของน ้า (Water Cycle) คือ ปรำกฎกำรณ์ที่น้้ำจำกแหล่งต่ำงๆ บนพื้นโลก 
เช่น ทะเล แม่น้้ำ คลอง กำรคำยน้้ำของพืช เป็นต้น เปลี่ยนแปลงสถำนะของน้้ำระหว่ำง
ของเหลว ของแข็งและก๊ำซ ตำมสภำพแวดล้อมที่น้้ำอำศัยอยู่หมุนเวียนไปเรื่อยๆ

วฏัจกัรของน ้า (Water Cycle)

18



1

2

3

การไหลในล้าน ้าหรือน ้าท่า 
(streamflow or runoff)

น ้าท่าผิวดิน (overland flow 
หรือ surface runoff)

การไหลเสริม หรือน ้าท่าใต้ผิวดิน 
(interflow)

น ้าใต้ดิน (groundwater flow)

การไหลในล้าน ้า
2 ที่ไหลออกช้าๆ และ 3 รวมกัน เรียกว่า 
การไหลพื นฐาน (base flow)ที่มา : อารียา ฤทธิมา, 2561

1 และ 2 ที่ไหลออกกทันที รวมกัน เรียกว่า 
น ้าท่าโดยตรง (direct runoff)

ลกัษณะการไหลในล าน ้า

19



การกระจายความเรว็ของน ้าในหน้าตดัแบบต่างๆ

20



การไหลแบบคงที่ (steady flow) หำกพิจำรณำกำรไหลของน้้ำที่ผ่ำนไปในภำชนะรูปร่ำงคงที่ (solid boundary) 
กำรไหลแบบคงที ่จะมีควำมลึก พื้นที่หน้ำตัด ควำมเร็ว และอัตรำกำรไหลของน้้ำไม่เปลี่ยนแปลงกับเวลา

การไหลแบบไม่คงที่ (unsteady flow) หำกพิจำรณำกำรไหลของน้้ำที่ผ่ำนไปในภำชนะรูปร่ำงคงที่ (solid 
boundary) จะมีควำมลึก พื้นที่หน้ำตัด ควำมเร็ว และอัตรำกำรไหลของน้้ำเปลีย่นแปลงกับเวลา

รางทดลอง คลองชลประทาน

การไหลในล้าน ้า น ้าขึ นน ้าลงน ้าท่วม

การจ าแนกการไหลโดยพิจารณาความผนัแปรกบัเวลา

21



การไหลแบบสม่้าเสมอ (uniform flow) หำกพิจำรณำกำรไหลของน้้ำที่ผ่ำนไปในภำชนะรูปร่ำงคงที่ กำรไหลแบบสม่้ำเสมอ จะเป็นกำรไหลที่
ความลึกคงทีต่ลอดระยะทำง   (สมกำรแมนนิ่ง, สมกำรเชซี)่ 

คลองชลประทาน

รางทดลอง

การไหลในล้าน ้า

สมการแมนน่ิง

การจ าแนกการไหลโดยพิจารณาความผนัแปรกบัต าแหน่ง
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การไหลแบบไม่สม่้าเสมอ (non-uniform flow) หำกพิจำรณำกำรไหลของน้้ำที่ผ่ำนไปในภำชนะรูปร่ำงคงที่ กำรไหลแบบไม่สม่้ำเสมอ 
จะเป็นกำรไหลที่ความลึกไม่คงท่ีตลอดระยะทำง แบ่งเป็น 2 ลักษณะ คือ กำรไหลเปลี่ยนแปลงน้อย (gradually varied flow) และกำรไหล
เปลี่ยนแปลงเร็ว (rapidly varied flow) (สมกำรพลังงำน)

การไหลในล้าน ้า

การไหลเปลี่ยนแปลงน้อย

การไหลเปลี่ยนแปลงเร็ว
น ้ากระโดด, น ้าตก

สมการพลังงาน

การจ าแนกการไหลโดยพิจารณาความผนัแปรกบัต าแหน่ง
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การไหลในล้าน ้า

การไหลแบบค่อยเป็นค่อยไป

ทางน ้าลาดน้อย

ทางน ้าลาดชัน

ตวัอย่างรปูตดัการไหล (flow profile)

24



การไหลในล้าน ้า

แบบต่อเนื่อง

ค่า n ลดลง น ้าขึ น-น ้าลง

ตวัอย่างรปูตดัการไหล (flow profile)

25



การวดัข้อมลูน ้าท่า
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การวัดข้อมูลน ้าท่า

1. การเข้าถึง (accessibility) คือ สำมำรถเข้ำไปตรวจวัดระดับน้้ำและ
อัตรำกำรไหลของน้้ำได้ทุกสภำพอำกำศ โดยเฉพำะฝนตกหนักและน้้ำท่วม

2. ความเพียงพอ (adequacy) คือ สำมำรถวัดระดับน้้ำและอัตรำ              
กำรไหลของน้้ำ ได้ที่ระดับควำมสูงน้้ำต่ำงๆ 

3. การมีเสถียรภาพ (stability) คือ ตั้งอยู่ในบริเวณหน้ำตัดทำงน้้ำที่
มั่นคง มีเสถียรภำพ ไม่เกิดกำรกัดเซำะหรือตกตะกอน ทำงน้้ำตรง ไม่มีผล
จำกน้้ำเท้อ (backwater) น้้ำขึ้นน้้ำลง (tidal) มีควำมสัมพันธ์ระหว่ำง
อัตรำกำรไหลของน้้ำและระดับน้้ำคงที่หรือไม่เปลี่ยนแปลงง่ำย 

4. ความถาวร (permanency) คือ ตั้งอยู่ในบริเวณที่ไม่ถูกรบกวนจำก
สำเหตุใดๆ ที่จะท้ำให้ข้อมูลผิดพลำดหรือสูญหำย

การเลือกท่ีตัง้สถานีวดัน ้า

27



การวัดข้อมูลน ้าท่า

การวัดรูปตัดขวางล้าน ้า คือ กำรวัดระดับท้องน้้ำของล้ำน้้ำทั้งบนตลิ่งและในล้ำน้้ำ
โดยอ้ำงอิงระดับจำกหมุดหลักฐำน

ใช้กล้องระดับ ใช้ RTK และ M9

รูปตัดขวางล้าน ้า

การวดัรปูตดัขวางล าน ้า
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การวัดข้อมูลน ้าท่า

ค่าระดับน ้า (stage) คือ ระดับของผิวน้้ำเหนือเส้นอ้ำงอิงที่ก้ำหนด 
- ระดับน้้ำทะเลปำนกลำง, รทก. (mean sea level, msl)
- ระดับอ้ำงอิงสมมุติ, รสม. (assume datum) กรณีไม่มีหมดหลักฐำน (bend mark)

ต้นเดียว

แบ่งส่วน

แบบเอียง

แบบลูกลอย แบบใช้ฟองอากาศ

การวดัระดบัน ้า

29

แผ่นวัดระดับน ้า หรือ ไม้วัดระดับน ้า (staff gauge)
เป็นแผ่นขีดบอกระดับน้้ำ ควรติดตั้งบนฐำนที่มั่นคง       
ไม่ทรุดตัว

เครื่องวัดระดับน ้าแบบบันทึกข้อมูล เป็นเครื่องมือที่วัดระดับน้้ำที่
เปลี่ยนแปลงตำมเวลำ ได้แก่ แบบลูกลอย (floating gauge recorder) 
และแบบใช้ฟองอำกำศ (bubble gauge) 



การวัดข้อมูลน ้าท่า

1. เครื่องวัดความเร็วกระแสน ้าแบบถ้วย (cup type)

2. เครื่องวัดความเร็วกระแสน ้าแบบใบพัด (propeller)

3. เครื่องวัดความเร็วกระแสน ้า แบบ 
Electromagnetic Current Meter

การวดัความเรว็ของน ้า
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การวัดข้อมูลน ้าท่า

วิธีวัดความเร็วของน ้า-พื นที่หน้าตัด (velocity-area method) คือหำอัตรำกำรไหลของน้้ำโดยวัดควำมเร็วของน้้ำจำกเครื่องวัด
ควำมเร็วกระแสน้้ำแบบต่ำงๆ (แบบถ้วย แบบใบพัด และแบบ Electromagnetic) และวัดพื้นที่กำรไหลจำกำรหยั่งควำมลึก

วิธีการแล่นเรือ (moving boat method) คือหำอัตรำกำรไหลของน้้ำอัตโนมัติ โดยวัดควำมเร็วของน้้ำและหน้ำตัดจำกเครื่อง
Acoustic Doppler Current Profiler (ADCP)

River surveyor M9 RiverRay ADCP

การวดัอตัราการไหลของน ้า (Q=AVเฉล่ีย)

31

1. วิธีการวัดโดยตรง คือ กำรวัดควำมเร็วของน้้ำ (velocity) และพ้ืนที่หน้ำตัดกำรไหล (flow area) โดยตรง



การวัดข้อมูลน ้าท่า

2. วิธีการวัดทางอ้อม คือ กำรหำอัตรำกำรไหลของน้้ำที่ไม่ได้วัดข้อมูลกำรไหลของน้้ำโดยตรง

วิธีวัดผ่านโครงสร้างชลศาสตร์ (flow measuring structures) คือ กำรไหลผ่ำนฝำยน้้ำล้น (weirs) รำงวัดน้้ำ (flumes) ประตูน้้ำ
แบบไหลลอด (sluice gates) 

ฝายสันคมรูปสี่เหลี่ยม

ฝายสันคมรูปสามเหลี่ยม

ฝายสันกว้าง32



การวัดข้อมูลน ้าท่า

รางน ้า
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การวัดข้อมูลน ้าท่า

ประตูน ้าแบบไหลลอดบานตรง

ประตูน ้าแบบไหลลอดบานโคง้

34



การวัดข้อมูลน ้าท่า

วิธีความลาด-พื นที่ (slope area method) คือ หำอัตรำกำรไหลของน้้ำในช่วงน้้ำหลำก ที่ไม่มีแผ่นระดับหรือเครื่องวัดระดับน้้ำ
อัตโนมัติ โดยดูจำกครำบน้้ำ แนวตะกอนดิน รอยวัชพืช  

ดูจากระดับน ้าที่เกิดขึ น 2 ต้าแหน่ง
ห่างกัน 75 เท่าของความลึกเฉลี่ย

ระดับของหน้าตัดต่างกันมากกว่า 0.15 เมตร
ใช้ n จากลักษณะล้าน ้า
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หลกัการของความสมัพนัธร์ะหว่าง
ระดบัน ้าและอตัราการไหลของน ้า

36



ความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า/ปริมาณการไหลของน ้า (stage discharge relationship) เมื่อพิจำรณำ
หน้ำตัดล้ำน้้ำใดๆ จะพบว่ำอัตรำกำรไหลของน้้ำในล้ำน้้ำจะสูงขึ้นตำมระดับน้้ำที่เพิ่มขึ้น และลดลงตำมระดับน้้ำที่ลดลง ซึ่งถ้ำมีข้อมูล
อัตรำกำรไหลของน้้ำที่ระดับน้้ำต่ำงๆ จะสำมำรถเขียนกรำฟควำมสัมพันธ์ระหว่ำงระดับน้้ำและอัตรำกำรไหลของน้้ำ ได้เป็น เส้นโค้ง  
การไหลของน ้า หรือ โค้งปริมาณน ้า หรือ ความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า “Rating Curve”

สาเหตุการเปลี่ยนแปลงในแต่ละปี มำจำกหน้ำตัดล้ำน้้ำอำจมีกำรกัดเซำะหรือตกตะกอน ควำมลำดชันพลังงำนจำกน้้ำเท้อ            
ระดับน้้ำจำกล้ำน้้ำสำขำไหลลงมำให้ท้ำยน้้ำสูงขึ้น 

โค้งพาราโบล่า

หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า

ข้อมูลส้ารวจ

ความสมัพนัธร์ะหว่างระดบัน ้าและอตัรา        
การไหลของน ้า (stage discharge relationship) 
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หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า

ตวัอย่างของ Rating Curve ในล าน ้า 
ณ ต าแหน่งสถานีตรวจวดัน ้าท่า
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การต่อขยายเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า (Extension of Rating Curve) 
เนื่องมำจำกกำรสร้ำงโค้งควำมสัมพันธ์ระหว่ำงระดับน้้ำกับอัตรำกำรไหลของน้้ำ ส่วนใหญ่จะมำจำกข้อมูลในช่วง
ของกำรไหลของน้้ำไม่มำกนักโดยในช่วงเวลำที่เกิดน้้ำท่วมจะไม่สำมำรถวัดอัตรำกำรไหลของน้้ำได้ แต่จะสำมำรถ
บันทึกได้เฉพำะระดับน้้ำ จึงต้องมีกำรต่อขยำยเส้นโค้งเพื่อหำค่ำอัตรำกำรไหลของน้้ำที่เกิดขึ้น 

หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า

การต่อขยายเส้นโค้งความสมัพนัธร์ะหว่าง 
ระดบัน ้ากบัอตัราการไหลของน ้า

การต่อแบบมีหลักการ
1. การต่อขยายแบบวิธีกราฟ (graphical extension)

2. การต่อขยายแบบเลขก้าลัง (logarithmic extension)

3. การต่อขยายแบบสตีเวนส์ (Stevens AD extension)

4. การต่อขยายแบบใช้สูตรแมนนิ่ง (Manning conveyance factor extension)
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การต่อขยายแบบวิธีกราฟ (graphical extension)

เป็นวิธีที่ง่ำยที่สุด โดยลำกต่อเส้นโค้งปริมำณแบบธรรมดำด้วยสำยตำ วิธีนี้จะเหมำะสม
เมื่อมีกำรต่อขยำยออกไปไม่มำก และช่วงของโค้งปริมำณน้้ำที่ระดับน้้ำสูงๆ ที่ได้จำกกำรวัด
แสดงเป็นรูปโค้งชัดเจนและง่ำยต่อกำรต่อขยำยออกไป 

40

ต่อขยาย



การต่อขยายแบบเลขก้าลัง (logarithmic extension)

วิธีนี้ควำมสัมพันธ์ระหว่ำงระดับน้้ำและอัตรำกำรไหลของน้้ำจะเป็นลักษณะเลขก้ำลังตำมสมกำร

Q = 𝑘(𝑔 − 𝑎)𝑏

โดยที่ Q คือ อัตรำกำรไหลของน้้ำ
       g คือ ระดับน้้ำ (เมตร, เมตร รทก.) 
         b และ k คือ ค่ำคงที่ส้ำหรับสถำนีหนึ่งๆ

a คือ ระยะระหว่ำงระดับ 0 ของแผ่นวัด
ระดับถึงระดับที่ไม่มีกำรไหลของน้้ำ (เมตร, เมตร รทก.) 
ในโปรแกรมจะเรียกว่ำ ค่า Offset

log𝑄 = 𝑏𝑙𝑜𝑔 𝑔 − 𝑎 + 𝑙𝑜𝑔𝑘

ความสัมพันธ์แบบเลขก้าลัง 

หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า

y = 𝑏𝑥 + 𝑐 หา a, k และ b ?????????

Q =
1

𝑛
𝐴𝑅

2
3𝑆

1
2

สมการแมนนิ่ง

Q =
1

𝑛
𝑦

5
3𝑆

1
2 ล้าน ้ากว้าง
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1. การหาค่า k และ b เม่ือรู้ค่า a

ใช้ Excel ลากแนวโน้มสมการยกก้าลัง

ใช้ Excel หรือ กระดาษกราฟธรรมดา โดยคิด log ก่อน

ลากในกระดาษกราฟ log-log

𝑏 =
∆𝑄

∆(𝑔 − 𝑎)

หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า

ได้ค่า k และ b จาก
โปรแกรม

k = Q ที่จุด 
     (g-a) เท่ากับ 1

log𝑄 = 𝑏𝑙𝑜𝑔 𝑔 − 𝑎 + 𝑙𝑜𝑔𝑘

b = ค่า slope

Lo
g 

Q

Log (g-a) k = 𝑎𝑛𝑡𝑖 log 𝑐

y = 𝑏𝑥 + 𝑐

Q = 𝑘(𝑔 − 𝑎)𝑏

ได้ค่าต่างๆ แทนในสมการ Q 
เมื่อรู้ค่าระดับน ้า g สูงๆ จะสามารถหา Q ได้

42



หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า

2. การหาค่า k และ b สมมุติค่า a คงที่

𝑏 =
∆𝑄

∆(𝑔 − 𝑎)

k = Q ที่จุด (g-a) เท่ากับ 1

1) พล็อตข้อมูลระดับน ้า (g) และอัตราการไหล (Q) ในกราฟ
ธรรมดา 

2) ลากเส้นต่อเส้นโค้งตัดแกน y จะได้ a โดยประมาณ 
3) ค้านวณค่า g-a 
4) พล็อตค่า g-a และ Q ในกราฟ log-log หรือ ln-ln 
5) ดูว่าเป็นแนวเส้นตรงหรือไม่ ถ้าไม่เป็นให้สมมุติค่า a ใหม่ และท้า 

3) ถึง 5) จนเป็นแนวตรง
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ได้ค่าต่างๆ แทนในสมการ Q 
เมื่อรู้ค่าระดับน ้า g สูงๆ จะสามารถหา Q ได้

Q = 𝑘(𝑔 − 𝑎)𝑏

ลากต่อเส้น 
เมื่อรู้ค่าระดับน ้า g สูงๆ อ่านค่า Q ได้

ในโปรแกรมที่อบรมนี จะใช้
วิธีการสมมุติ a 

หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า44



การต่อขยายแบบสตีเวนส์ (Stevens extension)

Q = 𝐴𝐶 𝑅𝑆

โดยที่ C คือ สัมประสิทธิ์ควำมขรุขระของเชซี่
        S คือ ควำมลำดของเส้นลำดพลงังำน

A คือ พื้นที่รูปตัดของล้ำน้้ำ
R คือ รัศมีชลศำสตร์

ถ้ำสมมุติว่ำ 𝐶 𝑆 มีค่ำคงที่ และแทนค่ำรัศมีชลศำสตร์
ด้วยควำมลึกเฉล่ีย D จะได้สมกำร ดังนี้

Q = 𝐾𝐴 𝐷

𝐾 =
∆𝑄

∆(𝐴√𝐷)

หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า

รู้ระดับ ไปค้านวณ       อ่าน Q𝐴 𝐷

วิธีนี้ใช้สูตรของเชซี่ (Chezy) และรูปตัดของล้ำน้้ำที่เกิดอัตรำกำรไหลสูงสุดในเวลำเกิดน้้ำท่วม 
มำขยำยโค้งปริมำณน้้ำ 
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การต่อขยายแบบใช้สูตรแมนนิ่ง                     
(Manning conveyance factor extension)

วิธีนี้ใช้สูตรของแมนนิ่ง (Manning) และรูปตัดของล้ำน้้ำที่เกิดอัตรำกำรไหลสูงสุดในเวลำเกิดน้้ำท่วม 
มำขยำยโค้งปริมำณน้้ำ 

Q =
1

𝑛
𝐴𝑅

2
3𝑆

1
2

Q =
1.49

𝑛
𝐴𝑅

2
3𝑆

1
2

Stage

เทอม              เรียกว่ำ conveyance factor
ค้ำนวณจำกรูปตัดกำรไหลของน้้ำ R=A/P

𝐴𝑅2/3

หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า

รู้ระดับจะได้ ไปค้านวณ Q
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การเลือกค่า Manning’s n ในการปฏิบัติงาน

หลักการของความสัมพันธ์ระหว่างระดับน ้าและอัตราการไหลของน ้า47



ความส าคญัของเส้นโค้งความสมัพนัธ์
ระหว่างระดบัน ้ากบัอตัราการไหลของน ้า
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ความส้าคัญของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

❑ ใช้หาค่าอัตราการไหลของน ้าในช่วงน ้าท่วม 
ซึ่งสามารถวัดได้เฉพาะระดับน ้า

❑ ใช้หาค่าอัตราการไหลของน ้าใน
ช่วงเวลาต่างๆ ต่อเนื่อง ซึ่งการวัด
ตลอดจะมีค่าใช้จ่ายและใช้เวลามาก 
(ข้อมูลระดับน ้าวัดต่อเนื่อง)

❑ .สะดวกในการใช้งานส้าหรับ       
การหาค่าโดยประมาณ

ความส าคญัของ Rating Curve
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ความส้าคัญของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

ตวัอย่างของ Rating Curve ในล าน ้าต่างๆ
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ลกัษณะของเส้นโค้งความสมัพนัธ์
ระหว่างระดบัน ้ากบัอตัราการไหลของน ้า
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ความส้าคัญของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

❑ Rating Curve แบบปกติ

❑ Rating Curve กรณีน ้าล้นตลิ่ง

❑ Rating Curve กรณีตลิ่งต้่าหรือตลิ่ง 2 ชั น

❑ Rating Curve กรณีมีฝายท้ายแนว

❑ Rating Curve กรณีฝายเหนือแนว-ท้ายแนว (บานเปิด-ปิด)

โดยทั่วไปที่พบมีประมาณ 7 รูปแบบหลักๆ

❑ Rating Curve กรณีน ้าขึ น-น ้าลงจากทะเล

❑ Rating Curve กรณีคลื่นน ้าหลาก (flood wave)

ลกัษณะของ Rating Curve
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ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

1. Rating Curve แบบปกติ
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ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า54



ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

2. Rating Curve กรณีน ้าล้นตลิ่ง
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ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า56



ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า57



ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

3. Rating Curve กรณีตลิ่งต่้าหรือตลิ่ง 2 ชั น
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ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

ฝายยางแก้งสนามนาง

4. Rating Curve กรณีมีฝายท้ายแนว
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ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า60



ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า61



ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

5. Rating Curve กรณีฝาย/ประตูระบายน ้า 
เหนือแนว-ท้ายแนว (บานเปิด-ปิด)
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ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

6. Rating Curve กรณีคลื่นน ้าหลาก
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ลักษณะของเส้นโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

แม่น ้าเจ้าพระยา

7. Rating Curve กรณีน ้าขึ น-น ้าลงจากทะเล
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ขอบคุณครับ



วิธีและเทคนิคการสร้างโค้ง
ความสัมพันธ์ระหว่างระดับน ้า

กับอัตราการไหลของน ้า 
(Rating Curve)

โดย
ดร.เมธาฤทธิ์ แนมสัย

หัวหน้าฝ่ายวิจัยและพัฒนาวิศวกรรมการบริหารจัดการน ้า
ส่วนวิจัยและพัฒนาด้านวิศวกรรม ส้านักวิจัยและพัฒนา 

กรมชลประทาน



❑ ข้อมูลส้าหรับสร้างโค้งความสัมพันธ์ระหว่าง
ระดับน ้ากับอัตราการไหลของน ้า

❑ ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่าง 
ระดับน ้ากับอัตราการไหลของน ้า

❑ หลักการการแบ่งช่วงเวลาในกรณีของ         
การค้านวณโดยใช้ 2 R หรือ 3 R 

❑ กรณีศึกษาตัวอย่างการจัดท้า Rating Curve

❑ ปัญหาของการจัดท้า Rating Curve

หัวข้อที่น้าเสนอ
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ข้อมูลส ำหรบัสร้ำงโค้งควำมสมัพนัธ์
ระหว่ำงระดบัน ้ำกบัอตัรำกำรไหลของน ้ำ

3



ข้อมูลส้าหรับสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

ส ำรวจข้อมูล
ระดับน  ำ ส ำรวจข้อมูล

อัตรำกำรไหล
ของน  ำ

กำรส ำรวจข้อมลูระดบัน ้ำรำยวนัและอตัรำกำรไหลของน ้ำ
จำกระดบัน ้ำในสนำม
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ข้อมูลส้าหรับสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า
แบบฟอร์มบันทึกข้อมูลระดับน  ำรำยวัน (อท.01)

กำรบนัทึกข้อมูลในแบบฟอรม์ อท.01
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ข้อมูลส้าหรับสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

แบบฟอร์มบันทึกข้อมูล
จุดส ำรวจปริมำณน  ำ (อท.02)

กำรบนัทึกข้อมูลในแบบฟอรม์ อท.02

6



ขัน้ตอนกำรสร้ำงโค้งควำมสมัพนัธ์
ระหว่ำงระดบัน ้ำกบัอตัรำกำรไหลของน ้ำ

7



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

พล๊อตจุด
ส้ารวจ

ปริมาณน ้าจาก
สนาม

พล๊อตค่าระดับน ้าเฉลี่ย
จนครบปีน ้า
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ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

• ก ำหนดขนำดมำตรำส่วน (scale) 
ของระดับน  ำ, ปริมำณน  ำให้
เหมำะสมกับช่วงของข้อมูล

• พิจำรณำให้ครอบคุลมระดับตลิ่ง 
และปริมำณน  ำสูงสุด

• แกนตั ง (y) เป็นค่ำระดับน  ำ (gage 
height)

• แกนนอน (x) เป็นค่ำปริมำณน  ำ 
(discharge) และช่วงเวลำเป็นวัน

9

ขั นตอนที่ 1 การก้าหนดขนาดมาตราส่วน



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

 น ำข้อมูลระดับน  ำเฉลีย่รำยวันจำก 
อท.1-01 มำพล็อตลงในกรำฟ

10

ขั นตอนที่ 2 พล็อตค่าระดับน ้าเฉลี่ยรายวัน



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

 น ำข้อมูลระดับน  ำเฉลีย่รำยวันจำก 
อท.1-01 มำพล็อตลงในกรำฟ

11

ขั นตอนที่ 2 พล็อตค่าระดับน ้าเฉลี่ยรายวัน



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

❑ น ำค่ำปริมำณน  ำที่ได้จำกกำร
ส ำรวจภำคสนำม (อท.1-02)              
มำพล็อตลงในกรำฟ

❑ เขียนวันที่ที่ส ำรวจก ำกับไว้ตำม   
จุดส ำรวจทุกจุด

12

ขั นตอนที่ 3 พล็อตค่าปริมาณน ้า



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

❑ น ำค่ำปริมำณน  ำที่ได้จำกกำร
ส ำรวจภำคสนำม (อท.1-02)              
มำพล็อตลงในกรำฟ

❑ เขียนวันที่ที่ส ำรวจก ำกับไว้ตำม   
จุดส ำรวจทุกจุด

13

ขั นตอนที่ 3 พล็อตค่าปริมาณน ้า



ขั นตอนที่ 4 ก้าหนดค่าระดับศูนย์ปริมาณน ้า 
(zero flow)

ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

 พิจำรณำจุดจุดส ำรวจระดับน  ำ-
ปริมำณน  ำต่ ำสุดเพื่อก ำหนด
ก ำหนดค่ำระดับศูนย์ปริมำณน  ำ 
(zero flow)

 ระดับจะไม่ต่ ำกว่ำระดับท้องน  ำ 
(riverbed)

 จะอยู่ใกล้เคียงกับระดับน  ำต่ ำสุด
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ขั นตอนที่ 5 จัดท้ากราฟ Velocity Curve 
และ Area Curve

ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

 น ำค่ำควำมเร็ว (Velocity) 
และพื นที่ (Area) จำกกำร
ส ำรวจปริมำณน  ำ (อท.02) มำ
จัดท ำกรำฟ Velocity Curve 
และ Area Curve

Area
Velocity
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ขั นตอนที่ 5 จัดท้ากราฟ Velocity Curve 
และ Area Curve

ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

 น ำค่ำควำมเร็ว (Velocity) 
และพื นที่ (Area) จำกกำร
ส ำรวจปริมำณน  ำ (อท.02) มำ
จัดท ำกรำฟ Velocity Curve 
และ Area Curve
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ขั นตอนที่ 6 ลากเส้นโค้งปริมาณน ้า 
(Rating Curve)

ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

 พิจำรณำกำรกระจำยของจุดส ำรวจ
ปริมำณน  ำ เพื่อหำแนวในกำรสร้ำง
โค้งปริมำณน  ำ (rating curve)

 ลำกโค้งปริมำณน  ำ โดยเริ่มจำก 
zero flow เฉลี่ยกลุ่มของจุดส ำรวจ
ปริมำณน  ำ โดยลำกเส้นให้คลุม 
ระดับน  ำสูงสุด 
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ขั นตอนที่ 6 ตรวจสอบความน่าเชื่อถือของโค้ง
ปริมาณน ้า (Rating Curve)

ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

 น ำค่ำปริมำณน  ำและระดับควำมลึกของน  ำที่อ่ำนได้จำก
โค้งปริมำณน  ำมำตรวจสอบด้วยกระดำษ log-log 
scale 

 ค่ำที่ได้จะเป็นเส้นตรงในกราฟ log-log scale ใน
กรณีที่เส้นโค้งปริมำณน  ำที่ลำกเป็นเสน้โคง้ปกติ
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ขั นตอนที่ 7 จัดท้าตารางน ้า (Rating Table)

ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

❑ อ่ำนค่ำระดับน  ำกับปริมำณน  ำจำกโค้งปริมำณน  ำ  
ทุกๆ 10 เซนติเมตร เริ่มจำก zero flow จนถึง 
ระดับน  ำสูงสุด และกรอกลงในแบบฟอร์ม อท.38

❑ จะต้องมีค่ำควำมต่ำงของปริมำณน  ำเพิ่มขึ นหรือ
เท่ำกัน

❑ กระจำยตำรำงน  ำ (rating table) ทุกๆ 1 เซนติเมตร
ในแบบฟอร์ม อท.38
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ขั นตอนที่ 8 ค้านวณค่าปริมาณน ้าเฉลี่ยรายวัน 

ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

 ท ำกำรค ำนวณค่ำปริมำณน  ำเฉลี่ยรำยวัน ลง
แบบฟอร์ม อท.26 โดยกำรลอกค่ำระดับน  ำ
เฉลี่ ย รำยวัน  และอ่ ำนจำกปริมำณน  ำ         
ที่ตรงกันในตำรำง Rating table ตำมที่   
แตกไว้แล้ว จนครบปีน  ำ 
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ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

H. 67

1  2  3  4  5
STATION 

CODE

S.4B

SEQUENCE

0010

0020

ABOVE ELEV. FROM MONTH DATE

0030 0.00 1 OCT 4 2

R1 R2 TO FROM TO FROM TO FROM TO

0040 1 26 3112

0050

0051

0052

0053

0054

0055

0056

0057

0058

0059

115.10116.00 126.00114.40 94.00

113.10 51.75

114.30 90.00 114.90

114.1072.00

109.30 0.00 109.50 0.50

113.50 62.75 82.50

110.90 10.00

111.00 35.75 113.00 49.25

113.70 68.75 113.80

111.90

116.781 109.283 12 115.99 6.00

180.75

116.20 195.25

116.00115.40 142.50 115.50

110.60 7.00

148.50

25.75 112.40

110.20 4.00

18.75

114.60 102.50

101

R2

FROM TO

ANNUAL  MAX.  MOMENTARY

R1R1

GAGE HEIGHT
Q

G.H.

ELEV.

117.095

ELEV.

CMS.

4

TO

3

270614

R1

CMS. G.H.

5

CMS.G.H.

Coding Form No.1
อ.ท.๖๗

STREAM  GAGING  &  DISCHARGE

HYDROLOGY     NO.   DATE FROM

R2

CMS.

RATING  TABLE

G.H.

HC2 038   Y/2013

s
e

t

CMS. G.H.

 6  7  8  9  10
WATER 

YEAR

Pasak

         STREAM

Mueang,  Mueang, Phetchabun,S.4B

2013

  STATION NAME,   AMPHOE,  PROVINCE , (CODE)

11   12   13    14    15    16    17    18    19    20    21    22    23    24    25    26    27    28    29    30    31    32    33    34    35    36    37    38   39    40    41    42    43    44    45    46    47    48   49    50    51    52    53    54    55    56    57    58    59    60    61    62    63    64    65    66    67    68    69    70    71    72    73    74    75    76    77    78    79    80 

            RIVER            River  System

Pasak Pasak

BOTTOM ELEV.

DAILY GAGE HEIGHTZERO GAGE AT RIVER BEDRIGHT BANK

ELEV. AT HOURS

106.500

POINT REVISION

LEFT BANK

MSL

Hydrology Division

R
A

T
I
N

G
  
  
 T

A
B

L
E

  
  
  
 D

A
T

A
  
  
  
  
  
(
R

!)

1

 A.D.  

MSL. 

errors S Q. ,K.M.

DRAINAGE  AREA

Royal Irrigation Department.

2

11.25 111.50

115.70 161.00 115.90 174.00
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ขั นตอนที่ 9 อ่านค่าระดับน ้าและปริมาณน ้า
บันทึกลงใน Coding Form (อท.67)



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า22
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ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า23

ขั นตอนที่ 10 น้าข้อมูลเข้าระบบคอมพิวเตอร์ 
Stream Gaging & Discharge



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

➢ ค่ำเฉลี่ยระดับน  ำรำยเดือน
➢ ค่ำระดับน  ำสูงสุดเฉลี่ยประจ ำเดือน
➢ ค่ำระดับน  ำต่ ำสุดเฉลี่ยประจ ำเดือน
➢ ค่ำระดับน  ำสูงสุดประจ ำปี และวันที่ เวลำที่เกิด
➢ ค่ำปริมำณน  ำรำยรำยเดือน รำยปี
➢ ค่ำปริมำณน  ำเฉลี่ยรำยเดือน รำยปี
➢ ค่ำปริมำณน  ำเฉลี่ยสูงสุดประจ ำเดือน ประจ ำปี
➢ ค่ำปริมำณน  ำเฉลี่ยต่ ำสุดประจ ำเดือน ประจ ำปี
➢ ค่ำปริมำณน  ำรวมรำยเดือน รำยปี (ล้ำนลบ.ม.)
➢ ค่ำปริมำณน  ำสูงสุดประจ ำปี
➢ ค่ำ Runoff yield (ลิตร/วินำท/ีตร.กม.)
➢ ค่ำ Momentary peak yield (ลิตร/วินำที/ตร.กม.)

24

ขั นตอนที่ 11 ค้านวณหาค่าต่างๆ



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า

25

ขั นตอนที่ 11 ค้านวณหาค่าต่างๆ



ขั นตอนการสร้างโค้งความสัมพันธ์ระหว่างระดับน ้ากับอัตราการไหลของน ้า26

ขั นตอนที่ 12 น้าข้อมูลระดับน ้าและปริมาณ
น ้าจัดเก็บในฐานข้อมูล Hydrologydb



หลกักำรกำรแบง่ช่วงเวลำในกรณีของ
กำรค ำนวณโดยใช้ 2 R หรือ 3 R 
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หลักการการแบ่งช่วงเวลาในกรณีของการค้านวณโดยใช้ 2 R หรือ 3 R

กำรแบ่งช่วงเวลำกำรใช้เส้นโค้งปริมำณน  ำ (Rating curve) เกิดขึ นเมื่อเส้นโค้ง
ปริมำณน  ำมีกำรแยกตัวชัดเจนของกลุ่มจุดส ำรวจปริมำณน  ำ ซึ่งพบใน 3 กรณีคือ

1. กรณีเกิดน  ำเท้อจำกฝำยชั่วครำว ฝำยถำวร เขื่อนทดน  ำ อ่ำงเก็บน  ำ ซึ่งเป็น       
กำรเท้อของน  ำในระดับน  ำต่ ำ

2. กรณีเกิดกำรเท้อจำกกำร Routing ของระดับน  ำสูงหรือระดับน  ำท่วม ท ำให้เกิด
กำรแยกตัวกันของจุดส ำรวจปริมำณน  ำในระดับสูง โดยสำมำรถแยกได้เป็นปริมำณน  ำในช่วง
ขำขึ น (Rising) และปริมำณน  ำในช่วงขำลง (Falling)

3. กรณีเกิดกำรเปลี่ยนแปลงของท้องน  ำอย่ำงฉับพลัน โดยมีกำรกัดเซำะท้องน  ำ 
ก่อนเกิดปริมำณน  ำนอง (flood) ท ำให้ระดับท้องน  ำมีกำรยกตัวสูงขึ นเนื่องจำกตะกอนทับถม

กำรแบง่หรือแยกช่วงกำรอ่ำนเส้นโค้ง               
ปริมำณน ้ำ (Period of Curve)
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หลักการการแบ่งช่วงเวลาในกรณีของการค้านวณโดยใช้ 2 R หรือ 3 R

กำรแยกช่วงเวลำของ Rating Curve 
โดยพิจำรณำจำกจุดส ำรวจที่ได้

ตวัอย่ำงกำรแบง่หรือแยกช่วงกำรอ่ำนเส้น
โค้งปริมำณน ้ำ (Period of Curve)
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หลักการการแบ่งช่วงเวลาในกรณีของการค้านวณโดยใช้ 2 R หรือ 3 R30



หลักการการแบ่งช่วงเวลาในกรณีของการค้านวณโดยใช้ 2 R หรือ 3 R31



หลักการการแบ่งช่วงเวลาในกรณีของการค้านวณโดยใช้ 2 R หรือ 3 R32



กรณีศึกษำตวัอย่ำงกำรจดัท ำ 
Rating Curve
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กรณีศึกษาตัวอย่างการจัดท้า Rating Curve

แม่น ้ำมีรอบกำรขึน้ลง (Loop Stage)
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กรณีศึกษาตัวอย่างการจัดท้า Rating Curve
จุดส้ารวจปริมาณน ้าน้อย 1

จดุส ำรวจปริมำณน ้ำน้อย
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กรณีศึกษาตัวอย่างการจัดท้า Rating Curve

จุดส้ารวจปริมาณน ้าน้อย 2
36



กรณีศึกษาตัวอย่างการจัดท้า Rating Curve

จุดส้ารวจปริมาณน ้าน้อย 3
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กรณีศึกษาตัวอย่างการจัดท้า Rating Curve

กำรส ำรวจปริมำณน ้ำไม่ครบถ้วนตำมรอบของระดบัน ้ำ
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ปัญหำของกำรจดัท ำ 
Rating Curve
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ปัญหาของการจัดท้า Rating Curve40



ปัญหาของการจัดท้า Rating Curve41



ปัญหาของการจัดท้า Rating Curve42



ปัญหาของการจัดท้า Rating Curve43



ปัญหาของการจัดท้า Rating Curve44



ปัญหาของการจัดท้า Rating Curve45



ปัญหาของการจัดท้า Rating Curve46



ปัญหาของการจัดท้า Rating Curve47



ปัญหาของการจัดท้า Rating Curve48



ปัญหาของการจัดท้า Rating Curve49



ปัญหาของการจัดท้า Rating Curve50



ปัญหาของการจัดท้า Rating Curve51



ปัญหาของการจัดท้า Rating Curve52



ปัญหาของการจัดท้า Rating Curve53



ปัญหาของการจัดท้า Rating Curve54



ปัญหาของการจัดท้า Rating Curve55



ปัญหาของการจัดท้า Rating Curve56



ปัญหาของการจัดท้า Rating Curve57



ปัญหาของการจัดท้า Rating Curve58



ปัญหาของการจัดท้า Rating Curve59



ปัญหาของการจัดท้า Rating Curve60



ปัญหาของการจัดท้า Rating Curve61



ปัญหาของการจัดท้า Rating Curve62



ปัญหาของการจัดท้า Rating Curve63



ปัญหาของการจัดท้า Rating Curve64



ปัญหาของการจัดท้า Rating Curve65



ปัญหาของการจัดท้า Rating Curve66



ปัญหาของการจัดท้า Rating Curve67



ปัญหาของการจัดท้า Rating Curve68



ปัญหาของการจัดท้า Rating Curve69

กรณีมีฝายทา้ยแนวส ารวจ 500 ม.

ระดบัสนัฝาย

เคร่ืองสูบน ้า



ปัญหาของการจัดท้า Rating Curve70



ปัญหาของการจัดท้า Rating Curve71



ปัญหาของการจัดท้า Rating Curve72

ผิวน ้า

สนัฝาย



ปัญหาของการจัดท้า Rating Curve73

ขรน ทุ่งสมัฤทธ์ิ ทา้ยแนว 16 กม.
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การใช้งานโปรแกรม AQUARIUS 
 
 
 
 
 
 

ส่วนอุทกวิทยา 
สำนักบริหารจัดการน้ำและอุทกวิทยา กรมชลประทาน 

 
 

 
 



 

 
 

คำนำ 
 

  การสร้างโค้งความสัมพันธ์ระดับน้ำกับปริมาณน้ำ (Rating Curve) เป็นขั ้นตอนหนึ่ง 
ในการวิเคราะห์ข้อมูลปริมาณน้ำท่าเพ่ือใช้วิเคราะห์ วิจัยในงานทางด้านอุทกวิทยา และใช้ประกอบการติดตาม
สถานการณ์น้ำ เดิมมีการจัดทำบนกระดาษกราฟ ซึ่งมีข้ันตอนซับซ้อนและมีความล่าช้า ปัจจุบันด้วยเทคโนโลยี
ที่มีความทันสมัย มีการนำคอมพิวเตอร์และซอฟต์แวร์ต่างๆ เข้ามาช่วยในการทำงาน โปรแกรม AQUARIUS  
เป็นโปรแกรมในการจัดการกับฐานข้อมูลน้ำท่าอย่างมีประสิทธิภาพ ได้ถูกนำมาใช้ในการสร้างโค้งความสัมพันธ์
ระดับน้ำกับปริมาณน้ำ (Rating Curve)  เพื่อลดขั้นตอนกระบวนการในการทำงาน ทําให้เกิดความรวดเร็วใน
การทำงานและสามารถจัดทำรายงานต่างๆได้ง่ายขึน้ 
  คู่มือการใช้งานโปรแกรม AQUARIUS เล่มนี้ จัดทำเพื่อเป็นแนวทางวิธีการใช้งานโปรแกรม 
คณะผู้จัดทำหวังเป็นอย่างยิ่งว่าคู่มือเล่มนี้ จะเป็นประโยชน์ต่อเจ้าหน้าที่ส่วนอุทกวิทยา สำนักบริหารจัดการน้ำ
และอุทกวิทยา กรมชลประทาน ในการจัดทำโครงความสัมพันธ์ระดับน้ำกับปริมาณน้ำ เพื่อประโยชน์ในการ
วิเคราะห์สถิติข้อมูลทางอุทกวิทยา และใช้ประกอบในการติดตามสถานการณ์น้ำเพ่ือการบริหารจัดการน้ำ และ
นําไปพัฒนาต่อยอดในการทำงานด้านอุทกวิทยาต่อไปในอนาคต 
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คู่มือ AQUARIUS 2025 

บทที่ 1 – การสร้างสถานีและกล่องข้อมูล 

1.1 ทีอ่ยู่ของโปรแกรม Aquarius  
  - เมื่อทำการ Login โดยใช้อินเตอร์เน็ตภายในของกรมชลฯ สามเสน : http://10.28.1.201/AQUARIUS/ 

 - เมื่อทำการ Login โดยใช้อินเตอร์เน็ตภายนอก : http://aquarius.rid.go.th/aquarius/ 

1.2 กรอก Username และ Password จากนั้น กด Sign in เพ่ือเข้าใช้งาน 

 

1.3 สร้างสถานี (Location) โดยคลิกที่ New Location 

 

 

 

 

http://10.28.1.201/AQUARIUS/
http://aquarius.rid.go.th/aquarius/
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- กรอกข้อมูลของสถานี (UTC Offset กำหนดเป็น + 07:00 เสมอ) จากนั้นคลิก Save เพ่ือทำการบันทึก 

 
 

1.4 สร้างกล่องข้อมูล โดยคลิกท่ี Hamburger Menu   
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1.4.1 สร ้างกล ่องข ้อม ูลสำหร ับระด ับน ้ำ  โดยคล ิกที่  Hamburger Menu  และเล ือก  
New Basic Time-Series กรอกข้อมูล ดังต่อไปนี้ แล้วกด Save Change 

Label ชื่อกล่องข้อมูล logger 

Parameter ตัวแปรข้อมูล Stage 

Units หน่วยข้อมลู m 

Measurement Method วิธีการวัด None / Float / non - subm pressure transducer 

Interpolation การแก้ไขข้อมูล Instantaneous Values 

Define Gaps ช่องว่างของข้อมลู 1440 

UTC Offset ค่าพ้ืนฐานเวลา + 07:00 (Default)  

1.4.2 สร้างกล่องข้อมูล สำหรับการทำงานแก้ไขระดับน้ำ (Working) โดยคลิกที่  Hamburger 
Menu  และเลือก New Derived Time-Series และทำตามข้ันตอน ดังต่อไปนี้ 

- คลิก Edit Processing Period เพ่ือกำหนดกระบวนการการทำงานแก้ไขข้อมูลระดับน้ำ 

 
 

- Processing Type เล ือก Pass Through เพ ื ่อกำหนดกระบวนการส ่งผ ่านข ้อม ูลระด ับน้ำ  
โดยไม่มีการแก้ไขข้อมูล 
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  - ในหัวข้อ Processing Input นี้ เป็นการกำหนดสถานี (Location) และข้อมูลที ่จะดึงมาใช้งาน  
และกำหนดวิธีการตรวจวัด (Measurement Method) เพื่อเป็นข้อมูลนำเข้า (Data Input) สำหรับกล่อง
ข้อมูลนี้ ซ่ึงในที่นีค้ือข้อมูลระดับน้ำจากสถานีตรวจวัด (Stage. Logger) 
 

 

 
 

  - คลิก Time-Series Attributes เพ่ือกรอกรายละเอียดของสถานี ตามตัวอย่าง 

 
 
 
 
 
 



- 5 - 
 

 
 

 *** หากระดับน้ำเป็น รสม. ให้ทำตามข้อ 1.4.3 หากระดับน้ำเป็น รทก. แล้ว ข้ามไปทำข้อ 1.4.4 *** 
 

  1.4.3 สร้างกล่องข้อมูล สำหรับคำนวณระดับน้ำให้เป็นหน่วย เมตร (รทก.) โดยคลิกที่  และ 
เลือก New Derived Model และทำตามข้ันตอน ดังต่อไปนี้ 

 - เลือก Edit Processing Period 
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 -  เ ล ื อก  Calculate ในช ่ อง  Process Type ส ่ วน ในช ่ อง  Formula สร ้ า งส ู ตรจากสมการ  
y = x1 + ศูนย์เสาระดับ (Zero guage : Z.G.) เพื ่อคำนวณให้ระดับน้ำอย ู ่ ในหน่วย เมตร (รทก.)  
เมื่อกด Validate เพื่อตรวจสอบสมการ หากปรากฏข้อความ “Formula is valid” แสดงว่าสมการถูกต้อง 
สามารถนำไปใช้ในการคำนวณได้ 

 

 - กรอกข้อมูลในหัวข้อ Process Input โดยในหัวข้อ Time-Series ให้เลือกค้นหากล่องระดับน้ำ 
Stage Working ที่สร้างไว้ก่อนหน้านนี้ เพ่ือนำมาคำนวนแปลงค่าเป็น ร.ท.ก. จากนั้นคลิก OK 
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- กรอกข้อมูลในหัวข้อ Time-Series Attribute  ตามภาพด้านล่าง และกด Save Changes 

 

1.4.4 สร้างกล่องข้อมูล สำหรับสร้างข้อมูลระดับน้ำ (Stage) รายวัน โดยคลิกที ่  และ 
เลือก New Derived Time-Series และทำตามขั้นตอนดังต่อไปนี้ เพื่อกำหนดกระบวนการและข้อมูลนำเข้า
เพ่ือคำนวณอัตราการไหลรายวัน 

 

 - เลือก Edit Processing period 

 

ช่ือของกล่องข้อมูลเพื่อให้ทราบว่าเป็นข้อมูลที่แปลงเป็น ร.ท.ก. แล้ว 
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  - กำหนดค่า Processing Type and Time period 

 

 - กำหนดค่า Process Input ตามรูป 

 

 

 

 

เลือกเพื่อคำนวนค่าสถิต ิ

เลือกเพื่อคำนวณค่าสถติิ เฉลีย่รายวัน 

กรณีระดับน้ำ รทก. ใช้ Time Series 
ของ Stage MSL 
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 - กำหนดรายละเอียดการคำนวนที่ Computation Details 

 

 - กรอกข้อมูลในหัวข้อ Time-Series Attribute 

 

 

กำหนดช่ือกล่องข้อมูล ระดับน้ำเฉลี่นรายวัน 
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1.4.5 สร้างกล่องข้อมูล สำหรับการทำงานเกี่ยวกับ Rating Curve โดยคลิกที่ Hamburger Menu 
และเลือก New Rating Model และทำตามข้ันตอน ดังต่อไปนี้ 

- Rating Model Description กรอก log method ในช่อง Label 

 

- Parameters and Units เป็นการกำหนดข้อมูลนำเข ้าและผลลัพธ ์ รวมถึงหน่วยของข้อมูล   
มีรายละเอียด ดังนี้ 

 
 
 
 
 
 
 
 
 
 
 

กำหนดช่ือกล่องข้อมูล 
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1.4.6 สร้างกล่องข้อมูล สำหรับคำนวณอัตราการไหล (Discharge) รายชั่วโมง ตามข้อมูลระดับน้ำ 
(หากระดับน้ำเป็นรายชั่วโมง อัตราการไหลที่คำนวณได้ก็จะเป็นรายชั่วโมง หากระดับน้ำเป็นราย 3 ชั่วโมง 
อัตราการไหลก็จะเป็นราย 3 ชั่วโมง) โดยคลิกที่ Hamburger Menu และเลือก New Derived Time-Series 
และทำตามข้ันตอนดังต่อไปนี้ เพ่ือกำหนดกระบวนการและข้อมูลนำเข้าเพ่ือคำนวณอัตราการไหลรายชั่วโมง 

 - เลือก Edit Processing Period 

 

 - Processing Type and Time Period ช่อง Process Type เลือก Rating Model Derived 

 
 

 - กำหนดข้อมูล Process Inputs  
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 - กรอกข้อมูลในหัวข้อ Time-Series Attribute 

 
 

 

กำหนดช่ือกล่องข้อมูล 

กรณีระดับน้ำ รทก. ใช้ Time Series 
ของ Stage MSL 
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1.4.7 สร้างกล่องข้อมูล สำหรับคำนวณอัตราการไหล (Discharge) รายวัน โดยคลิกที่ Hamburger 
Menu และเลือก New Derived Time-Series และทำตามขั้นตอนดังต่อไปนี้ เพื่อกำหนดกระบวนการและ
ข้อมูลนำเข้าเพ่ือคำนวณอัตราการไหลรายวัน 

 - เลือก Edit Processing period 

 

 - กำหนดค่า Processing Type and period  

 

 - กำหนดค่า Process Input 
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 - กำหนดค่า Computation Details 

 

 

- กรอกข้อมูลในหัวข้อ Time-Series Attribute ตามภาพ 

 

 

 

กำหนดช่ือกล่องข้อมูล ปริมาณน้ำเฉลี่ยรายวัน 
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 เมื่อสร้างกล่องข้อมูลครบแล้ว จะปรากฏกล่องข้อมูลต่างๆ ดังรูป 

กรณีท่ี 1 ระดับน้ำ รสม. หรือ ระดับน้ำ รทก.ที่ได้จากการนำเข้าข้อมูล 

 

กรณีท่ี 2 ระดับน้ำ รทก.ที่คำนวณจากระดับน้ำ รสม. 

 

*** หน่วยของข้อมูลระดบันำ้รายชั่วโมงและข้อมูลระดับน้ำจาก Field Visit (อท.2) จะต้องเปน็หน่วยเดียวกัน *** 
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1.5 สรางกล่องข้อมูลอัตโนมัติโดยใช เว็บ API http://aquarius.rid.go.th/apiaq/  

 1.5.1 ลงชื่อเขาใชงาน 

 

 

 

 1.5.2. เลือกแถบเมนู LOCATION เพ่ือสร้างสถานี 

 

 
 
 
 
 

http://aquarius.rid.go.th/apiaq/
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 1.5.3 ใสรายละเอียดของสถานี  
  - ชอง LOCATION IDENTIFIER ใหตั้งชื่อสถานี เชน N1_2018_RID 
  - ชอง NAME ใสชื่อแม่น้ำ ภาษาอังกฤษ เชน Nan  
  - ช่อง LOCATION FOLDER ให้พิมพ์รหัสของศูนย์อุทกฯ ที่สักกัด เช่นภาคเหนือใช้ 01 
แล้วกดปุ่ม TAP ในคีย์บอร์ด 
  - ชอง Description ใสรายละเอียดที่อยู่สถานี - ชอง LATITUDE ใสคาพิกัด ละติจูด  
  - ชอง LONGTITUDE ใสคาพิกัด ลองจิจูด 
  - ชอง Stage Logger (mins) ใสคาความคลาดเคลื่อนของระยะเวลา (Gap Tolerances)  
   - หากข้อมูลเป็นรายชั่วโมงท้ังปใชคา 60 นาที  
   - หากข้อมูลมีหลายชวงเวลาในปเดียวกันใชคา 1440 นาที  
  - กด SAVE เพ่ือบันทึกและสร้างสถานี 

 
  - เมื่อเสร็จแล้วเว็บเบราว์เซอร์จะปรากฏข้อความ Create New Location Success ดังภาพ 

 



คู่มือ AQUARIUS 2025 

บทที่ 2 – การนำเข้าข้อมูล 

ในการสร้าง Rating Curve โดยใช้โปรแกรม Aquarius นั้น ต้องนำเข้าข้อมูล 2 ประเภท คือ 
  1. ข้อมูลระดับน้ำรายชั่วโมง 
  2. ข้อมูล Field Visit จากภาคสนาม (อท.02) 
มีรายละเอียด ดังนี้  

2.1 ข้อมูลระดับน้ำรายชั่วโมง  การนำเข้าข้อมูลระดับน้ำรายชั่วโมง จะต้องมีการจัดทำรูปแบบ (Format) 
ของข้อมูลก่อน  

2.1.1. การจ ัดร ูปแบบ (Format) ข ้อม ูล โดยเตร ียมข้อมูลให ้อย ู ่ ในร ูปแบบ Time series  
ตามท่ีโปรแกรมกำหนด 

- จัดรูปแบบข้อมูลโดยใช้งานเว็บไซต์ http://aquarius.rid.go.th/apiaq/ 

- ใส่ Username และ Password เพ่ือลงชื่อเข้าใช้ 

 

 

 

 

 

http://aquarius.rid.go.th/apiaq/
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- เมื่อลงชื่อเข้าใช้งานแล้ว ให้เลือกเมนู HYDRO FORM NO.1 เพ่ือใช้จัดเรียบข้อมูลระดับน้ำ 

 

- กด Browse เพื ่อเลือกไฟล์นำเข้าข้อมูลจากไฟล์ข้อมูลระดับน้ำรายชั ่วโมง (C-Form)  
โดยเป็นไฟล์ xls. และกด Upload เพ่ือแสดงผลข้อมูลบนเว็บ  

- โปรแกรมจะอ้างอิงช ื ่อสถานีและปีข ้อมูลในช ีท C-Form จากไฟล์ที ่นำเข ้า ดังนั้น 
ควรตรวจสอบชื่อและปีของข้อมูลให้ถูกต้องทุกครั้ง 
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- ปรากฏกราฟแสดงข้อมูลระดับน้ำที่ Upload เพ่ือตรวจสอบความถูกต้องของข้อมูล 

 

- ดาวนโ์หลดข้อมูลและบันทึกไฟล์เป็นนามสกุล .csv โดยคลิดที่  และเลือก Download CSV 

  - สามารถเปรียบเทียบข้อมูลระดับน้ำที่ Upload กับข้อมูลระดับน้ำรายชั่วโมงที่แสดงบน 
เว ็บ Hydro-app เพ ื ่อตรวจสอบความถ ูกต ้องข ้อม ูลและแก ้ไขข ้อม ูลได ้  ในแต ่ละเด ือน 
ในเมน ูEDIT MONTHLY 
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2.1.2 การ Append ข้อมูลระดับน้ำเข้าสู่โปรแกรม AQ 

- ในหน้า Springboard คล ิกเคร ื ่องม ือ APPEND LOGGER DATA จะปรากฏหน้าต่าง
เครื่องมือ APPEND LOGGER DATA 

 

- ในช่อง Logger file คลิกปุ่ม            เลือกไฟล์ .csv ที่ได้ทำการจัดเรียงข้อมูลระดับน้ำ 
ให้อยู ่ในรูปแบบ Time series ไว้แล้วในขั ้นตอนก่อนหน้านี้ สามารถตรวจสอบไฟล์ที่เลือกไว้ใน 
logger file โดยคลิกปุ่ม View Logger File  

- กำหนดรายละเอียดรูปแบบไฟล์ที่นำเข้ามาโดยการคลิกที่ Config Settings 
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-  จ ะป ร ากฏหน ้ า  Time Series – Import from File Wizard --- Step 1 of 4 ---  
Data Type ให้ทำการเลือกรูปแบบ (Format) ของไฟล์ที ่จะทำการ Append ซึ ่งไฟล์ระดับน้ำ  
Time series ท ี ่ เตร ียมไว ้ม ีนามสกุล .CSV  ให ้เล ือก File format เป ็น Text File (CSV,etc)  
แล้วกด Next 

 

 

 

 

 

 

 

 



-23- 
 

-  จ ะป ร ากฏหน ้ า  Time Series – Import from File Wizard --- Step 2  of 4 ---  
Import Option ตั้งค่าดังภาพ  แล้วกด Next 

 Start import at row : 1 หมายถึง แถว (row) ที่เริ่มนำเข้าข้อมูล  
  Number of headers : 2 หมายถึง จำนวน Column ที่จะนำเข้า  
  เลือก comma (,) ในการแบ่ง Column (เป็น Format ของ .CSV) 
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-  จ ะป ร ากฏหน ้ า  Time Series – Import from File Wizard --- Step 3 of 4 ---  
Column Parameters เป็นการกำหนดประเภทข้อมูลของแต่ละ Column ทำการตั้งค่าดังภาพ 

- Column 1 เป็น Date/Time กำหนด Format วันที่ของไฟล์ข้อมูล : dd/mm/yyyy HH:MM:SS 
ซึ่งต้องสอดคล้องกับข้อมูลที่จะนำเข้า  

- Zone : กำหนดค่าเป็น UTC + 07:00 ซึ่งเป็นโซนเวลาของประเทศไทย  

จากนั้นคลิก        เพ่ือไปยัง Column 2  
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- ใน Column 2 ซึ่งเป็น Column ค่าข้อมูลระดับน้ำ  
 - เลือก Data : Raw 
 - กำหนด Parameter : Stage (ประเภทข้อมูลน้ำเข้าเป็นข้อมูลระดับน้ำ) 
 - กำหนด Units : m (หน่วยวัดของข้อมูลระดับน้ำ) 
 - กำหนด Label : Datalogged (ชื่อของชุดข้อมูล) 
 - กด Next เพ่ือไปยังขั้นตอนต่อไป 
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-  จ ะป ร ากฏหน ้ า  Time Series – Import from File Wizard --- Step 4 of 4 ---  
Save Configuration เป็นการ save ข้อมูลการตั ้งค ่าร ูปแบบไฟล์นำเขา configuration (.cfg)  
เพื่อใช้ในการนำเข้าข้อมูลที ่มีรูปแบบข้อมูลแบบเดียวกันครั้งต่อไป โดยที่ไม่ต้องกำหนดรูปแบบ 
ของข้อมูลใหม่อีกครั้ง 
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 - ในหน้านี้ ให้ตรวจสอบจำนวน Point ที่จะทำการ Append ข้อมูล ซึ่งจะมีจำนวนเท่ากับ 
จำนวนแถว (Row) ในไฟล์ .csv ที่อยู่ในช่อง Logger File รวมถึงตรวจสอบวันที่เริ่มต้นและสิ้นสุด 
ในการ Append ข้อมูลและข้อมูลอื่นๆ 

 - ท ี ่ช ่อง Action เล ือก Append to selected dataset จากนั ้นที่ช ่อง Append to  
พิมพ์ stage logger แล้วคลิก Append เพ่ือส่งข้อมูลไปยังระบบ 
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 - เม ื ่อทำการ Append สำเร ็จแล ้ว จะปรากฏหน้าต ่าง ให ้คล ิก OK ในช ่อง Status  
จะปรากฏสถานะและจำนวน Point ที่ทำการ Append ส่วนช่อง History จะปรากฏประวัติการ 
Append 

 

 

 * ในกรณี จำนวน Status ของข้อมูลมีค่าน้อยกว่า จำนวน Point แสดงว่าเกิดปัญหา
ในการนำเข้าข้อมูล ให้ตรวจเช็ค format ของไฟล์ CSV ที่นำเข้าและทำการ Append ซ้ำอีกครั้ง 

 * หากต้องการลบข้อมูลที ่ Append ไปก่อนหน้าให้ กด active ข้อมูลในช่อง History  
แล้วกด Delete 
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2.1.3 การตรวจสอบและแก้ไขข้อมูลระดับน้ำ 

- ในหน้า Springboard เมื ่อ Append เสร็จแล้ว สามารถเปิดกราฟระดับน้ำได้โดยทำ
เครื่องหมายถูกหน้ากล่อง Stage Working แล้วคลิกเครื่องหมาย Correct Data  

 

- จะปรากฏหน้าต่าง Data Correction Toolbox และตารางข้อมูล หากกราฟที่ปรากฏ 
ไม่ถูกต้อง สามารถแก้ไขข้อมูลระดับน้ำในตารางได้  โดยการคลิกขวาที ่แถวที ่ต ้องการแก้ไข  
แล้วเลือก Correct 
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- จะปรากฏหน้าต่าง  Correction Control ทำการปรับแก้ค่าในช่อง Value จากนั้น 
คลิก Create และกด OK เพ่ือบันทึกข้อมูล 
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- ระดับน้ำที่แก้ไขจะปรากฏใน Column ชื่อ Corrected 
 

 

 

- เมื่อปิดหน้าต่าง คลิก Yes เพ่ือทำการ Save 
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2.2 การนำเข้า Field Visit (อท.2) 

 เป็นการนำเข้าข้อมูลสำรวจปริมาณน้ำจากภาคสนามเพ่ือเป็นข้อมูลประกอบในการจัดทำ Rating Curve 
โดยไฟล์ที่จะนำเข้าจะต้องมี Format ของข้อมูลเฉพาะตามที่โปรแกรมกำหนดเอาไว้ 

 2.2.1 การจัดรูปแบบข้อมูล Field Visit จากไฟล์ข้อมูล อท.02  

  - ลงชื่อใช้งานผ่านเว็บ API AQUARIUS http://aquarius.rid.go.th/apiaq/ 

- ใส่ Username และ Password เพ่ือลงชื่อเข้าใช้ 

 

  - เลือกแถบเมนู HYDRO FORM NO.2 ดังภาพ 

 

 

http://aquarius.rid.go.th/apiaq/
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  - ในแถบเมนู HYD FORM NO.2 ให้กด Browse เพ่ือค้นหาไฟล์ อท.02 นามสกุล xlsx  จากนั้น 
กด Upload  

 

  - ปรากฎหน้าต่างเพ่ือยืนยันการนำเข้าข้อมูล กด Confirm 
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  - แสดงผลข้อมูลที่นำเข้าแล้วดังภาพด้านล่าง 

 

  - ใส่รายระเอียดข้อมูลสถานี ในแถบ EXPORT FIELD VISIT 

   ช่อง LOCATION IDENTIFIER กรอกชื่อสถานีที่จะนำเข้าข้อมูล 
   ช่อง CHANNEL NAME กรอกชื่อแม่น้ำ 
   ช่อง PARTY กรอกชื่อผู้นำเข้าข้อมูล 
  - กด Export เพ่ือบันทึกไฟล์เก็บไว้ใช้นำเข้าในเมนู Field Visit ในโปรแกรม AQUARIUS 
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  2.2.2 การนำเข้าข้อมูลในหน้า Springboard ของสถานที่เลือก คลิกแท็บ Visit พื้นที่ Import Data 
ขวามือสำหรับ นำเข้าไฟล์ปริมาณน้ำ มี 2 วิธี 

  1. Drag and Drop สามารถลากไฟล์ข้อมูลสำรวจปริมาณน้ำมาวางไว้ในกรอบนี้ได้เลย 
  2. Select Files เลือกค้นไฟล์สำรวจปริมาณน้ำจากเครื่องคอมพิวเตอร์  
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- ไฟล์ Field Visit ที่จะทำการ Drag & Drop ให้จัดไว้ในรูปแบบ csv. (Comma delimited) ดังนี้ 

 

ช่ือข้อมูล รายละเอียด

LocationIdentifier ช่ือสถานี ต้องพิมพ์อย่างเดียวกับช่ือสถานีที่สร้างข้ึนทุกประการ

MeasurementId คร้ังท่ีท าการตรวจวัด

MeasurementStartDateTime วัน เดือน ปี และ เวลาที่เร่ิมตรวจวัด

MeasurementEndDateTime วัน เดือน ปี และ เวลาที่ตรวจวัดเสร็จ

StageAtStart ระดับน้ าเม่ือเร่ิมท าการตรวจวัด

StageAtEnd ระดับน้ าเม่ือท าการตรวจวัดเสร็จส้ินแล้ว

StageUnits หน่วยของระดับน้ า

Discharge ปริมาณน้ า

DischargeUnits หน่วยของข้อมูลปริมาณน้ า

ChannelName ประเภทช่องทางน้ า

ChannelWidth ความกว้างล าน้ า

WidthUnits หน่วยของความกว้างล าน้ า

ChannelArea พ้ืนท่ีล าน้ า

AreaUnits หน่วยของพ้ืนที่ล าน้ า

ChannelVelocity ความเร็วล าน้ า

VelocityUnits หน่วยของความเร็วล าน้ า

Party ช่ือผู้ท าการตรวจวัด

Comments หมายเหตุ (ไม่รองรับภาษาไทย)
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- เมื่อเตรียมไฟล์เรียบร้อยแล้ว ทำการ Drag & Drop (ลากและวาง) ในพ้ืนที่ที่กำหนด 

 

- เมื่อประมวลผลสำเร็จจะปรากฏ ดังภาพ 
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- ตรวจสอบความถูกต้องของข้อมูลที่ทำการ Drag & Drop โดยคลิกวันที่ในคอลัมน์ Visit Date 

 

จะปรากฏหน้าต่าง ดังนี้ 
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- คลิกท่ี Discharge – 36 จะปรากฏ ดังภาพ 
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- คลิกท่ี Discharge Section Main 
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คู่มือ AQUARIUS 2025 

บทที่ 3 – การสร้าง Rating Curve และ Rating Table 
 

 หลังจากที่สร้างกล่องข้อมูล Rating Model ในบทที่ 1 และนำเข้าข้อมูลการสำรวจภาคสนาม (Field 
Visit หรือ อท.02) ในบทที่ 2 ที่ผ่านมาแล้วนั้น ในบทนี้จะเป็นการสร้าง Rating Curve และ Rating Table  
โดยเริ่มจากการทำเครื่องหมาย √ หน้ากล่องข้อมูลตามลำดับดังแสดงในภาพ ประกอบด้วย 

 - ทำเครื่องหมาย √ กล่อง Stage-Discharge log method เพ่ือสร้าง Rating Curve 
 - ทำเครื่องหมาย √ กล่อง Stage MSL(ระดับน้ำ ร.ท.ม.) หรือ กล่อง Stage Working(ระดับน้ำ ร.ส.ม.)  
   เพื ่อแสดงระดับน้ำประกอบในหน้า Rating Development Toolbox หากไม่ทำเครื ่องหมาย √  
กล่อง Stage MSL จะไม่มีกราฟระดับน้ำปรากฎ 
     

 

 

 *ตัวอย่างกราฟระดับน้ำที่ประกฎเมื่อทำเครื่องหมาย √ กล่อง Stage MSL ดังภาพด้านล่าง (ข้อมูลระดับ
น้ำที่เลือกจะต้องมีหน่วยเดียวกับระดับของข้อมูลสำรวจปริมาณน้ำเพื่อให้สามารถแสดงผลในกราฟได้อย่างถูกต้อง) 

 

1 
2 
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3.1 คลิกที ่เครื ่องหมาย  ในแถบด้านบน เพื ่อเข้าสู่หน้าต่าง Rating Development Toolbox  
ดังภาพ 

 

3.2 คลิกเมาส์ที่ปุ่ม Select All Measurement Points  ในแท็บ Rating Zoom 1 เพื่อเลือกจุดสำรวจ
ทั้งหมด 
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3.3 ทำการกำหนดค่า Offset Manager ของสถานี ซึ่งค่า Offset คือค่าระดับน้ำที่เริ่มมีการไหล Zero Flow 
ในกรณีไม่ทราบ Zero Flow สามารถใช้คำสั่ง Get Best Scale Offset เพ่ือหาค่า Offset ที่เหมาะสมได ้

 - โดยทำเครื่องหมาย √ ในกล่อง  หน้า Offset 1 ใส่ค่า Offset หรือค่า Zero Flow ของสถานีนั้น 

ตามภาพ และตั้งระดับสเกลความละเอียดของการปรับได้ที่ช่อง Offset Step โดยกดที ่   

 

3.4 หลังจากที่ปรับค่า Offset ดูแล้ว คลิกเมาส์ที ่ปุ ่ม Add Rating Point  ในแท็บ Rating Zoom 1  
แล้วคลิกวางที่บริเวณมุมซ้ายล่างและมุมขวาบน ให้ครอบคลุมจุดสำรวจ 
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3.5 คลิก Auto Scale  ในแท็บ 001 เพ่ือปรับขนาดสเกลของแท็บ Rating Zoom 1 ให้มีความเหมาะสม 

 

 

3.6 การเคลื ่อนย้ายจุดสามเหลี ่ยม Rating Point ให้คลิกที ่ Move Rating Point  ตามภาพ จากนั้น 
คลิกเมาส์ซ ้ายค้างไว้ที ่จ ุดสามเหลี ่ยม Rating Point ที ่ต ้องการลาก เล ื ่อนเมาส์ไปยังตำแหน่งที ่ต ้องการ  
แล้วปล่อยเมาส์ 

 

 

 

 



-45- 
 
3.7 หลังจากที่เลื ่อนจุดสามเหลี่ยม Rating Point แล้ว จะสังเกตเห็นว่า จุดสำรวจในช่อง Shift Diagram  
มีการเคลื่อนที่/เปลี่ยนแปลงตามไปด้วย ซึ่งในช่องนี้จะเป็นตัวชี้วัดความถูกต้องของ Rating Curve ที่เราลาก 
โดยค่าที่ยอมรับความถูกต้องได้นั้น ต้องอยู่ระหว่าง -0.5 ถึง +0.5 

 

 

3.8 จุดสำรวจส่วนใหญ่ในแท็บ Shift Diagram อยู่ในช่วงค่าความถูกต้องที่ยอมรับได้ คือ ระหว่าง -0.5 ถึง 
+0.5 แล้ว แตว่่ายังมีจุดสำรวจที่ยังแตกออกไป เพียงแค่จุดเดียวตามภาพ 
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3.9 แท็บ Shift Diagram ให้ทำการคลิกเลือกจุดสำรวจที่แตก จากนั ้นในแท็บ Field Visit Table คลิก
เครื่องหมาย √ ออก เพ่ือตัดจุดสำรวจดังกล่าวออกไป ไม่นำมาร่วมคำนวณ  

 

3.10 หลังจากที่ทำการสร้าง Rating Curve แล้ว ให้ทำการ Set ช่วงเวลาที ่จะใช้ ที ่แท็บ Rating Period 
Manager จากนั้นทำการดับเบิ้ลคลิกท่ีแถบสีน้ำเงิน (001 W…)  
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3.11 กำหนดค่าเร ิ ่มต ้นและสิ ้นสุดสำหรับการใช้ Rating Curve จะกำหนดให้ใช ้ท ั ้งปีน ้ำ และเวลา 
ต้องกำหนดให้เลยเที่ยงคืนมา 1 วินาที มิเช่นนั้น ระบบจะไม่แสดงปริมาณน้ำเวลา 24.00 น. ของวันที่ 31 
มีนาคม เสร็จแล้วกด Apply 

 

3.12 เมื่อกำหนดช่วงเวลาในการใช้ Rating Curve แล้ว จะสังเกตเห็นว่าจุดสำรวจสีชมพู จะมีขนาดใหญ่ขึ้น
ตามภาพ 

 

 



-48- 
 
3.13 การ Export Rating Table โดยไปท่ี File > Expanded Rating Table… 

 

3.14 คลิกเลือก Base เพ่ือทำการ Export ทั้งหมด และเลือกท่ีเก็บไฟล์ โดยคลิกที่  จากนั้นกด OK 

 

 - Rating Table ที่ออกมา จะได้เป็นแบบ Text File และมีลักษณะดังภาพ 
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 - กรณีต้องการ Rating Table เป็นคู ่อันดับ ให้ทำเครื ่องหมาย ในกล่อง  Export in column 
format แล้วกด OK 

 

* ตัวอย่าง Rating Table แบบเป็น Column format แสดงคู่อันดับ ปริมาณน้ำ และระดับน้ำ 
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3.15 นอกจากนี้ สามารถ Export ตัว Rating Curve ได้ โดยคลิก Print/Export  ในแท็บ Rating Zoom 2 

 

3.16 เลือกรูปแบบไฟล์ที่ต้องการบันทึก สถานที่บันทึก ขนาด และความละเอียด จากนั้นกด Export 

 

 - โดย Rating Curve ที่ Export ออกมา ก็จะมีลักษณะตามภาพ 
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3.17 ทั ้งนี ้ หากไม่ต้องการให้ Rating Curve แสดงจุดสามเหลี ่ยม Rating Point และ จุดสำรวจสีเทา 
ที่ไม่ได้เลือก ให้ทำการคลิกออก ที่ปุ่มทั้งสองปุ่มในแท็บ 001 ในกรอบสีแดงตามภาพ แล้วทำการ Export 
Rating Curve อีกครั้ง 

 

 

  - Rating Curve ที่ Export ออกมา ก็จะมีลักษณะตามภาพ 
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3.18 การบันทึก Rating Curve ที่ได้จัดทำไปในโปรแกรม Aquarius นั้น ให้ไปที่ File > Save to Output 
Port(s) แล้วกดปิดโปรแกรมหรือกด Exit ออก 

 

 

3.19 เมื ่อสร้าง Rating Curve เสร็จแล้ว ให้ตรวจสอบข้อมูลปริมาณน้ำ ว่ามีข้อมูลแสดงและจุดสำรวจ 

อยู่ตามเส้นหรือไม ่โดยการทำเครื่องหมาย √ ที่กล่อง Discharge Working จากนั้นกดท่ีรูปเครื่องมือ  
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 - ซึ่งถ้าหากทำถูกต้องแล้ว จะมีข้อมูลแสดง และถ้าจุดสำรวจเกาะเส้นกราฟปริมาณน้ำ แสดงว่า 
Rating Curve ทีไ่ด้ทำการสร้าง มีความถูกต้องและสามารถนำ Rating Table ไปใช้งานต่อได้ 

 

3.20 การสร้าง Rating Curve ที่มากกว่า 1 Curve 

 

 จากภาพ หากพิจารณาจุดสำรวจคร่าวๆด้วยสายตา พบว่า จุดสำรวจได้แตกออกจากกันอย่างชัดเจน 
อย่างน้อยก็แบ่งเป็น 2 กลุ ่ม คือ น้ำสูงกับน้ำต่ำ ดังนั ้น ต้องมี Rating Curve มากกว่า 1 เส้น เพื ่อให้ 
มีความถูกต้องและรองรับข้อมูลทั้งสองกลุ่มนี้ แต่ทั้งนี้ ต้องทดลองทำดูก่อน เพราะบางพื้นที่อาจจะต้องมีถึง  
3 Curve 
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 ในตัวอย่างนี้ จะทำการสร้าง Rating Curve สำหรับน้ำสูงก่อน โดยวิธีการสร้างนั้น ก็ใช้วิธีการเดียวกัน
กับการสร้าง Curve เดี่ยว ดังที่กล่าวมาในช่วงต้นของบทท่ี 3 แต่จะแตกต่างกันตรงที่ Set ช่วง Rating Period 
Manager โดยจะไม่ Set รวมทีเดียวทั้งปีน้ำ แต่จะต้อง Set แยกเป็นช่วงตามระยะเวลาของจุดสำรวจและ 
Curve ทีจ่ะใช้ (วันที่เริ่มต้นและสิ้นสุด ดูได้จากจุดสำรวจ) 

 

 

3.21 เมื่อสร้าง Rating Curve เส้นแรกเสร็จแล้ว ควรทำการบันทึก โดยใช้คำสั่ง File > Save to Output 
Port(s) จากนั้น ใช้คำสั่ง Edit > Clone Rating… เพ่ือคัดลอกข้อมูลจุดสำรวจไปสร้าง Rating Curve เส้นที่ 2 
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3.25 ตั้งชื่อเส้นที่ 2 เพ่ือจะได้ไม่ซ้ำกับเส้นแรก และนำเครื่องหมาย √ หน้าข้อความ Measurement Settings 
และ Offset(s) ออก จากนั้น กด OK 

 

จะได้แท็บ 002 เพิ ่มเข้ามากล่องด้านบนซ้าย ดังภาพ ซึ ่งแท็บตัวนี ้เป็นแท็บในการแสดงว่าเราทำงาน 
อยู่ที่ Rating Curve เส้นไหน ทั้งนี้ หากต้องการกลับไปที่ Curve เส้นแรก ให้เลือกทีแ่ท็บ 001 
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3.23 ทำการเลือกจุดสำรวจที่ยังไม่ได้ใช้หรือจุดสำรวจที่แตกออกมาจาก Curve 001 ในแท็บ Field Visit Table  

 

3.24 ทำการย้ายจุดสามเหลี่ยม Rating Point ให้ครอบคลุมจุดสำรวจสำหรับ Curve 002 โดยใช้เครื่องมือ  
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 หรือถ้าหากไม่ย้าย Rating Point ด้วยเครื่องมือ  สามารถทำการลบจุดสามเหลี่ยม Rating Point 

ด้วยเครื่องมือ  จากนั้นดับเบิ้ลคลิกที่จุดสามเหลี่ยม Rating Point จะเป็นการลบออก แล้วทำการ Add 

Rating Point  เข้าไปใหม่ได้ 

 

3.25 หลังจากสร้าง Rating Point ให้กับจุดสำรวจสำหรับ Curve 002 แล้ว ก็ทำการกำหนดช่วงเวลาในแท็บ 
Rating Period Manager โดยกำหนดให้วันที่และเวลาต่อเนื่องกับ Curve 001 (วันที่และเวลาสิ้นสุดของ 002 
จะต้องเป็นวันที่และเวลาเดียวกันกับเริ่มต้น 001) จากนั้นกด Apply 
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 *ในการกำหนด Period เพื่อกำหนดเวลาของการใช้งาน Rating Curve ได้ง่ายขึ้น สามารถเข้าดู
รายละเอียดของเวลาได้ในแถบ Time Series View เพื่อให้เห็นกราฟช่วงเวลาของการเปลี่ยนแปลงระดับน้ำ
ในลำน้ำได้ชัดเจนขึ้น 

  - ทำการ  Zoom กราฟในช่วงที่ต้องการขยาย 

  - ใช้เครื่องมือ  Time Slider เลื่อนเส้นสีดำไปยังเวลาที่เราต้องการทราบ ดังภาพ 

 

 

3.26 หลังจากที่กำหนดช่วงเวลาให้กับ Curve 002 แล้ว สามารถนำทั้ง 2 Curve ดูซ้อนทับกันได้ โดยใช้ 
คำสั่ง Overlay Rating > Add Overlaid Rating… 
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3.27 กำหนดสีและขนาดที่ต้องการในช่อง Color กับ Line แล้วกด Overlay 

 

 

3.28 หลังจากกด Overlay แล้ว จะขึ้นแสดง 2 Curve ตามภาพ จากนั้น กด Auto Scale  ที่แท็บ 002 
เพ่ือปรับขนาดสเกลให้เหมาะสมและเห็นครอบคลุมทั้งหมด 
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 - หากกด Overlay แล้ว ไม ่ม ีอะไรเก ิดข ึ ้น ให ้ไปที่ คำส ั ่ง Overlay Rating > Overlaid Rating 
Properties… 

 

3.29 ทำเครื่องหมาย √ ในช่อง Show Curve แล้วกด Apply หรือหากต้องการเปลี่ยนสีและขนาดของ Curve 
Overlay ก็เปลี่ยนได้ทีข่ั้นตอนนี้เช่นเดียวกัน 

 

 

 



-61- 
 
3.30 หลังจากที่ทำการ Overlay ทั้ง 2 Curve เพื่อดูภาพรวมทั้งหมดแล้ว ปรากฏว่า ยังมีจุดสำรวจที่ยังแตก
ออกไป และยังไม่ได้นำมาใช้ใน Curve ที่ 2 อีกหลายจุด (ถ้ามีเพียงจุดเดียว สามารถตัดออกได้) จึงจำเป็นต้อง
สร้าง Curve ที่ 3 เพ่ือให้ครอบคลุมถึงจุดสำรวจเหล่านี้ด้วย ถึงแม้ว่าจุดสำรวจดังกล่าวทั้งหมดในระดับน้ำต่างๆ 
ปริมาณน้ำที่วัดได้จะเท่ากับ 0.00 ลบ.ม./วิ ก็ตาม  

 

3.31 ทำการ Clone Rating และเลือกจุดสำรวจที่ยังไม่ได้ใช้ เช่นเดียวกับขั้นตอนข้างต้น แต่ในขั้นตอนนี้  
ที่ต่างไป คือ จะไม่ทำการย้ายจุดสามเหลี่ยม Rating Point แต่จะทำการลบจุดสามเหลี่ยม Rating Point  

โดยใช้เครื่องมือ  แทน 
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3.32 เมื่อทำการลบจุดสามเหลี่ยม Rating Point แล้ว ให้ไปที่แท็บ Rating 

 

3.33 แม้ค่าระดับน้ำของจุดสำรวจที่เหลือจะแตกต่างกัน แต่ เนื่องจากค่าปริมาณน้ำ เท่ากับ 0.00 ลบ.ม./วิ 
เท่ากันในทุกการสำรวจอยู่แล้ว นั่นแสดงว่า น้ำไม่ไหล/น้ำเท้อจากฝายด้านท้าย ในที่นี้จึงใช้วิธีการกำหนดค่า
ให้กับจุดสามเหลี่ยม Rating Point แทนการคลิกเพ่ิมจุดแล้วลากวางเอง 

  - ใช้คำสั่ง Insert Below  ในแท็บเพ่ือเพ่ิมแถว 
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  - จากนั้น ดับเบิ้ลคลิกท่ีแถบสีน้ำเงิน แล้วใส่ค่าในช่อง Stage กับ Discharge 

 

 โดยค่าในช่อง Stage นั้น เป็นค่าต่ำสุดและค่าสูงสุดที่ได้จากจุดสำรวจที่ค่าปริมาณน้ำเท่ากับ 0 
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3.34 จากนั้นกำหนดช่วงเวลาสำหรับ Curve 003 (ช่วงแรก) ตามข้อมูลจุดสำรวจ โดยเริ่มตั้งแต่ต้นปีน้ำ ไป
จนถึงวันที่และเวลาที่เริ่มใช้ Curve 002 

 

 เนื่องจากตัวอย่าง ไม่มีข้อมูลจุดสำรวจในเดือนพฤศจิกายน ดังนั้น การกำหนดช่วงเวลา หรือ Set  
ช่วง Rating Period Manager ในช่วงที ่เหลือ ไปจนถึงสิ ้นปีน้ำ จึงพิจารณาใช้ Curve 003 แทนทั้งหมด  
เพราะมีข้อมูลจุดสำรวจช่วงปลายปีน้ำ (ทั้งนี้ หากมีข้อมูลจุดสำรวจในช่วงเดือนพฤศจิกายน และจุดสำรวจ
ดังกล่าวเข้ากับ Curve 002 สามารถกำหนดช่วงเวลาดังกล่าวให้ใช้ Curve 002 ได้ ด้วยวิธีเดียวกันดังต่อไปนี้) 

3.35 การกำหนดช่วงเวลาสำหรับ Curve 003 (ช่วงหลัง) ใช้เครื่องมือ Append  ในแท็บ Rating Period 
Manager  
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3.36 เลือก Curve ที่จะใช้ ในช่อง Rating และ กำหนดช่วงเวลาในช่อง Period จากนั้นกด OK 

 

 ผลลัพธ์ก็จะได้ Curve ทีแ่ยกตามช่วงเวลาต่างๆ ครอบคลุมจุดสำรวจครบทั้งปีน้ำ 

 

3.37 สามารถตรวจสอบกราฟปริมาณน้ำเบ ื ้องต ้น ในแถบ Output View โดยคลิกเคร ื ่องม ือ   
เพื่อเลือกข้อมูลที่จะใช้แสดง จากนั้น ใน Input Signal(s) ให้เลือกข้อมูลระดับน้ำที่จะใช้อ่าน Rating Curve 
ในตัวอย่างจะให้ระดับน้ำรายวัน Daily Stage จากนั้นกด OK จะได้กราฟปริมาณน้ำรายวันดังภาพ 
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3.38 การ Export Rating Table สำหรับสถานีที่มีหลาย Curve ไปที่ File > Expanded Rating Table… 

 

3.39 ในแถบ Dropdown ของช่อง Base ให้ทำการเลือก Rating Curve ที่ต้องการ Export ออกมาเป็น 

Rating Table (สามารถ Export ได้ที่ละ Curve เท่านั้น) เลือกที่บันทึกและตั้งชื่อไฟล์  จากนั้นกด OK  
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3.40 การตรวจสอบกราฟ Discharge อีกคร ั ้งเพื ่อตรวจสอบความถูกต ้อง  ในตัวอย ่างนี ้  ปรากฏว่า  
กราฟมีรูปร่างแปลกๆในช่วงเดือนพฤศจิกายนถึงเดือนธันวาคม ดังนั้น เพื่อความแน่ใจ ให้กลับไปแก้ไข 
ที่แท็บ Rating Period Manager โดยทดลองใช้ Curve 001 และ 002 

 

 - ทดลองแก้ไข ช่วงเดือนพฤศจิกายนถึงธันวาคม เป็น Curve 001 ปรากฏว่ากราฟเป็นดังภาพ  
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 - ทดลองแก้ไข ช่วงเดือนพฤศจิกายนถึงธันวาคม เป็น Curve 002 ปรากฏว่ากราฟเป็นดังภาพ  
เมือ่เปรียบเทียบกันแล้ว เหมาะสมและมีความเป็นไปได้มากท่ีสุด 

 

 - ดังนั้น ผลลัพธ์การแบ่งช่วงเวลาของสถานีตัวอย่างนี้ ทั้ง 3 Curve จึงปรากฏดังภาพ 
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* ทั้งนี้ ถ้าหาก Clone Rating ออกมาเกินจำนวนที่ต้องการจะสร้าง หรือต้องการลบ Curve หมายเลขใด
หมายเลขหนึ่ง ก็สามารถลบได้ โดยคลิกแท็บ Rating ที่ต้องการจะลบ จากนั้นไปที ่เมนู File > Delete 
Current Rating 

     

* ระบบจะถามให้ยืนยันอีกครั้งว่าจะลบหรือไม่ คลิก Yes เพ่ือทำการลบ 

 

 

 

 

 

 

 

 

 



-70- 
 
*หากเผลอไปกดปิดแท็บย่อย หรือแท็บบางตัวหายไป หรือหน้าต่างของ Rating Development Toolbox  
ไม่ปกติเหมือนเดิม ดังภาพ 

 

 ให้ไปที ่View > Default Layout หน้าต่างหรือแท็บทุกอย่างก็จะกลับมาครบสมบูรณ์เหมือนเดิม 
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คู่มือ AQUARIUS 2025 

บทที่ 4 – การจัดทำรายงาน 

 

4.1 การจัดทำรายงานของโปรแกรม Aquarius อยู่ในเมนูที่ชื่อว่า Report : Create reports for 
selected data sets  

 

เมื่อ Click เข้าไปจะปรากฏหน้า Reporting - Generated Reports 



-72- 
 
โดยจะมี 6 เมนู แต่เมนูหลักๆ ที่ใช้ในแบบฝึกหัดนี้คือ 3 เมนูดังนี้ 

- Generated Reports 
- Change List 
- Daily Mean by Year 
 

 
 

4.1.1 Generated Reports จะใช้ในการแสดงรายงานทั้งหมดของทุก user ที่เคยส่งออกรายงานไว้ 
โดยผู้ใช้สามารถเลือกดูรายงานของช่วงเวลาที่ต้องการได้จาก Tab ด้านบน ได้แก่ Show reports generated 
during, Show reports generated by, Show reports containing 
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- Show reports generated during  คือการค้นหารายงานในช่วงเวลาที่ต้องการ สามารถเลือกได้
ว่าจะให้แสดงแบบใด เช่น Last Complete, Water year หรือ Date Range เป็นต้น 

 
 

- Show reports generated by คือ การค้นหารายงานจากชื่อ user ที่ต้องการ
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- Show reports containing คือ การค้นหารายงานจากสิ่งที่อยู่ในรายงาน 

 

4.1.2 Change List จะเป็นหน้าที่แสดงรายงานการเปลี่ยนแปลงของข้อมูล เช่น การสร้าง เพิ่มเติม หรือแก้ไข 
พร้อมทั้งบอกประเภทของการแก้ไข โดยสามารถเลือกช่วงเวลาที่ต้องการทราบ และรูปแบบของรายงาน 
ที่ต้องการได ้
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4.2 ขั้นตอนการเรียกดูรายงาน  

 ใน Tab Data Sets  ให้เลือกสถานีและ Parameter ที่เราต้องการจัดทำรายงาน ในแบบฝึกหัดนี้เลือก
สถานี Y1C_2016  Discharge Daily Mean 

 

 ปรากฎหน้าต่างดังภาพ
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จากนั้นไป Click ที่   แล้วเลือก Daily Mean by Year  

 

  เลือกช่วงเวลาข้อมูลใน Time Range และเลือกรูปแบบรายงานใน Report Format 

 

 ในหัวข้อ Report Parameters ให้ต ั ้งช ื ่อรายงาน และใส่คำอธิบายเกี ่ยวกับรายงาน จากนั้น 
กด Run Report เพ่ือประมวลผลรางาน 

  

เลือกช่วงเวลาของข้อมูลที่ต้องการทำรายงาน เลือกรูปแบบของรายงาน 

ตั้งชื่อรายงาน 

คำอธิบายเกี่ยวกับรายงาน 

กด Run Report 
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เมื่อ Run Report เสร็จ ตรง Generate Report จะขึ้นตัวเลขสีเขียวแจ้งเตือนพร้อมกล่องข้อความ จากนั้น 

click เข้าไป Generate Report เลือกสถานที่เราทำรายงานไว้ แล้วกดท่ี  เพ่ือเรียกดูรายงาน 

 

Click Link เพ่ือดูรายงาน 
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หน้าแสดงรายงานของ Daily Mean by Year หากต้องการนำไปใช้งาน click ขวา เลือก save as รูปแบบของไฟล์จะเป็นตามที่เรากำหนดไว้ตอนแรก 
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4.3 การเรียกดูการเปลี่ยนแปลงข้อมูลตามช่วงเวลา 

หากเราต้องการดูข้อมูลว ่ามีการจัดทำ เปลี ่ยนแปลง หรือแก้ไข อย่างไรบ้าง สามารถดูได้ 
จาก Change List โดยสามารถเลือกช่วงเวลาที่จะดูข้อมูลได้เหมือนกับ Generate Report และ Daily Mean 
by Year 
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 เลือกช่วงเวลาที่จะดูข้อมูล 

 

 

 

 

 

  

เลือกช่วงเวลาที่ต้องการ 

ตั้งชื่อรายงานและคำอธิบาย 

กด Run 

กดดูรายงาน 



-81- 
 
4.4 การนำรายงานจากโปรแกรม Aquarius มาจัดรูปแบบให้สอดคล้องกับ C-Form 

4.4.1 เปิดโปรแกรม Able2Extract Professional 

 

4.4.2 จากนั้น Click ที่ Open   เลือกไฟล์ที่ทำการบันทึกจากรายงาน (หน้า 78) และ Click Open 

 

4.4.3 หน้าต่างจะแสดงตารางรายงานที่เรา Export มาจากโปรแกรม Aquarius ในรูปแบบของ PDF File 
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4.4.4 แปลงรูปแบบไฟล์จาก PDF เป็น Excel โดย Click ที่  เพ่ือทำการเลือกข้อมูลในแผ่นงานทั้งหมด
ที่ต้องการแปลงรูปแบบไฟล์ จะปรากฏแถบสีฟ้าคลุมตัวอักษรทั้งหมดดังภาพด้านล่าง 

 

4.4.5 จากนั ้น Click    เพื ่อกำหนดรูปแบบที ่ต้องการ โดยในที ่นี ้ต ้องการให้เปลี ่ยนจาก PDF  
เป็น Excel จากนั้นจะปรากฏหน้าต่าง Convert to Excel ให้กด Convert 
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4.4.6 เลือกพ้ืนที่จัดเก็บที่ต้องการ โดยรูปแบบยังคงเป็น Excel โดยนามสกุลเป็นได้ท้ัง .xls และ .xlsx จากนั้น
กด Save 

 

ไฟล์ที่ถูกเปลี่ยนแปลงรูปแบบแล้วจะถูกเปิดขึ้นมาโดยอัตโนมัติ 

4.4.7 จัดรูปแบบของรายงานปริมาณน้ำเฉลี ่ยรายวันที ่ได้จาก Aquarius ให้สามารถแสดงรายละเอียด 
ในด้าน ผลรวม ค่าเฉลี่ย ค่าสูงสุด ค่าต่ำสุด ปริมาณน้ำในหน่วยล้านลูกบาศก์เมตร ปริมาณน้ำต่อพื้นที่รับน้ำ 
ตามรูปแบบของ C-Form 
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